
Overview of Printer Functions

The printer driver is software that specifies how to use the printing functions of this machine when printing from application software.

When you install the printer driver on your computer, you can use a variety of this machine’s printing functions. Furthermore, the printer driver supports a wide range of
connection methods and provides flexibility in various environments.



Preparation for Network Connection (for the Administrator)

Checking the network settings

Check that this machine is connected to the network. For details on the check procedure, refer to Here.

Configuring the network printing environment

Change the settings of this machine depending on the required printing protocol.

If the printing protocol is not specified before installation, Normal Printing (Port 9100) is selected for printing. Use Normal Printing (Port 9100) unless otherwise specified by
the administrator.

Secure Print (IPPS) cannot be set up using the installer.

The Internet Print (IPP) is not supported in the IPv6 environment.

Allowing device information to be acquired from the printer driver

Disable the OpenAPI authentication function. (In normal circumstances, you can use the default settings.)

When you allow acquisition of device information from the printer driver, the printer driver automatically obtains information such as what options are installed in this
machine and whether authentication settings have been configured.

For details on the setting procedure, refer to Here.

How to print Description

Normal Printing (Port 9100)
Make sure that the RAW port number has been set. (In normal circumstances, you can use the default settings.)

For details on the setting procedure, refer to Here.

Internet Print (IPP)
Check the IPP operating environment. (In normal circumstances, you can use the default settings.)

For details on the setting procedure, refer to Here.

Secure Print (IPPS)
Set up the IPPS operating environment. Communication between this machine and the computer is encrypted with SSL.

For details on the setting procedure, refer to Here.
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[Assign Account to Acquire Device Info] (Here
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Preparation for USB Connection

Change the current computer settings before installing the printer driver.

Open [Control Panel].

For information on how to display [Control Panel], refer to Here.

Click [System and Security] - [System].

Click [Advanced system settings] on the menu to the left.
The [System Properties] screen appears.

In the [Hardware] tab, click [Device Installation Settings].
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Select [No, let me choose what to do], select [Never install driver software from Windows Update.], then
click [Save Changes].

After you have installed the printer driver, change the setting back to [Yes, do this automatically (recommended)].



Click [OK] to close the [System Properties] screen.



Easy Installation Process of the Printer Driver

Types of printer drivers

The following types of printer drivers are available. Select the printer driver that meets your printing aims.

System environment requirements

The following system environment is required to use the printer driver.

Type Description

PCL
This is a standard driver for printing general office documents.

The printing speed is faster than the PS driver.

PS
This driver is effective for high-definition printing of data created in PostScript-supporting application software from Adobe or other
vendors.

This driver is often used in graphics and light printing applications where good color reproducibility is important.

FAX
This driver enables you to send a fax simply by operating the computer without outputting paper. For details on how to use this driver,
refer to [PC-FAX].

Item Specifications

Operating system Windows 7 Home Basic

Windows 7 Home Premium *

Windows 7 Professional *

Windows 7 Enterprise *

Windows 7 Ultimate *

Windows 8.1 *

Windows 8.1 Pro *

Windows 8.1 Enterprise *

Windows 10 Home *

Windows 10 Pro *

Windows 10 Enterprise *

Windows 10 Education *



Installing the printer driver

Install the printer driver using the installer.

Administrator privileges are required to perform this task.

Before using a USB connection, connect this machine to the computer using a USB cable. If a wizard screen appears to add new hardware, click [Cancel].

Insert the driver DVD into the DVD drive of the computer.

Make sure that the installer starts, and then proceed to step 2.

If the installer does not start, open the driver folder on the DVD, double-click [Setup.exe] (in the 32-bit environment) or [Setup64.exe] (in the 64-bit

environment), and proceed to step 2.

If the [User Account Control] window appears, click [Continue] or [Yes].

Select the [Agree the Software End User License Agreement.] check box.

Windows Server 2008 Standard *

Windows Server 2008 Enterprise *

Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise

Windows Server 2012 Datacenter

Windows Server 2012 Standard

Windows Server 2012 R2 Datacenter
Windows Server 2012 R2 Standard

Windows Server 2016 Datacenter

Windows Server 2016 Standard

Windows Server 2019 Datacenter

Windows Server 2019 Standard
* Supports the 32-bit (x86) or 64-bit (x64) environment.

CPU Any processor of the same or higher specifications as recommended for your operating system

Memory
Memory capacity as recommended for your operating system

Sufficient available memory space is required for your operating system and the applications to be used.



Select [Install printers/MFPs] in [Select menu to setup], and click [Next].
The connected printers are detected.

Select this machine from the list of detected printers.

If this machine is not detected, restart it.

Among the connected devices, only the target model is automatically detected and displayed. If multiple target models are displayed, check the IP addresses. 
You can check the IP address of this machine in the screen that is displayed by tapping [Utility] - [Device Information].

If the connection to this machine cannot be recognized, it is not displayed in the list. In this case, select [Specify manually.] to manually specify the IP address
and host name of this machine.



As needed, specify the default print type and the type of the driver you want to install.

When specifying the type of the driver you want to install, select the [Advanced Settings] check box, and also select the check box of the printer driver you
want to install in [Components to Be Installed]. For features of each driver, refer to Here. The PCL driver is installed by default.

In [Print Type Default Setting], you can select whether to install the driver that has 2-sided printing specified as the default, or to install the driver that has 1-
sided printing specified as the default. By default, the driver that has 2-sided printing specified as the default is installed.

Click [Next].
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Check the items to be installed, and click [Install].

Change the displayed name or print a test page as needed, and click [Finish].

After installation was completed, configure initial settings for the printer driver.

For details on the initial settings for the printer driver, refer to Here.

Performing a test print

Windows provides the test printing function. Perform a test print to check that the correct printing is possible.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Right-click the icon of this machine, and click [Properties] (or [Printer Properties]).

In the [General] tab, click [Print Test Page].

Setting Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name if necessary.

[Property] Sets the optional operating environment of this machine. For details, refer to Here.

[Print Setting] Changes the default print settings of this machine if necessary. For details, refer to Here.

[Print Test page] If necessary, print a test page to check that printing process works correctly.
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If test printing has succeeded, click [OK].

If test printing has failed, click [Troubleshoot] to find out how to solve the problem.



Configuring the Default Settings of the Printer Driver

Configuring the optional environment of this machine

When you use this machine for the first time, check that information such as what options are installed in this machine and whether authentication settings have been
configured is correctly reflected to the printer driver.

Display the [Properties] window of the printer driver.

For information on how to display the [Properties] window, refer to Here.

In the [Configure] tab, check the information such as what options are installed in this machine and
whether authentication settings have been configured.

By default, [Auto] in [Obtain Settings...] is enabled. The information on this machine is automatically obtained and reflected to [Device Option].

If the [Auto] of [Obtain Settings...] is disabled and if you click [Obtain Device Information], the current information of this machine is obtained and reflected on
the [Device Option].

If communication with this machine fails, set the [Device Option] manually. Select an item to change from the list, and set a value in the [Setting].
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Click [OK].

Changing the default print settings

If necessary, you can change the default print settings of the printer driver.

We recommend that you change the default settings to suit your environment.

Display the [Printing Preferences] window of the printer driver.



For information on how to display the [Printing Preferences] window, refer to Here.

Change the print settings, then click [OK].
The changed settings are applied when printing is performed from any application software.

Registering Frequently Used Print Settings (Here)
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Printing Operation Flow

Open document data using the application software. From the [File] menu, select [Print].

Check the [Printer Name] (or [Select Printer]) make sure that the desired printer has been selected.

The [Print] dialog box differs depending on the application.



Specify the print range and the number of copies to print.

Click [Properties] (or [Preferences]) to change the print settings of the printer driver as necessary.

The print settings you have changed here are reset to the defaults when you exit the application software. For information on how to change the default

values of print settings, refer to Here.

The printer driver has the function to easily recall frequently used print settings. For details, refer to Here.

Click [Print].
Printing is executed.

When [Secure Print Only] is set to [On] in [Device Option] in the [Configure] tab, the [Secure Print] window appears. For details on Secure Print, refer to
Here.
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Easily Recalling Frequently Used Print Settings

Registering frequently used print settings

You can register the current print settings as a favorite and recall it when executing printing.

When you register a frequently used combination of print settings as a favorite, you can easily apply all of those settings just by selecting the combination from the Favorite
Setting list, even if the combination is complicated as it contains settings on multiple tabs.

The following explains the procedure of favorite print setting.

In the [Printing Preferences] window, set the print conditions you want to register as a favorite.

Click [Add...].

When you edit an existing setting, select its name from the [Favorite Setting] , then click [Edit].



Enter the name of the favorite to be registered.

Set an icon, a comment and call options for the favorite settings if necessary.

Settings Description

[Name]
Enter the name of the favorite to be registered.
Use names that can easily be identified.

[Icon] Assign an icon to the favorite settings if necessary.

[Sharing] Select this check box when you want to share the favorite with other users.

[Comment]
Enter a comment to the favorite settings if necessary.
The comment is displayed when you place the mouse cursor over the favorite on the Favorite Setting list.

[Restore Items] The favorite settings may contain the size of original and the number of copies which are determined only when you
start printing. When you call the favorite settings, these options are not set by default. However, you can define these
options in the favorite settings if necessary.



Click [OK].
The print settings are registered as a favorite. You can select the favorite settings from the [Favorite Setting] list when starting printing.

Customizing the setting window

You can gather setting items from difference tabs and place them in [My Tab].

Registering frequently used setting items in [My Tab] enables you to change settings in one tab, without switching among multiple tabs.

This section describes how to edit [My Tab].

Click [My Tab] - [Edit My Tab...].

You can also register a function in [My Tab] by selecting [to the LEFT] or [to the RIGHT] from the [My Tab] menu that is displayed by right-clicking the function.

Select the check box of items to be retrieved.



From [Setting Item List], select the function you want to register in [My Tab], then click [to the LEFT] or [to
the RIGHT].

Clicking [to the LEFT] places the selected function in the area to the left of [My Tab] and clicking [to the RIGHT] places it in the area to the right of [My Tab].

An icon appears to the left of each function that is registered in [My Tab].



As necessary, move or delete the registered functions.

To move a function, select the function and click [Up], [Down], or [Left/Right].

To delete a function from [My Tab], select the function and click [Remove].



Click [OK].
This completes editing [My Tab].

From [My Tab Settings] in the [Settings] tab, you can configure display settings for My Tab. For details, refer to Here.
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Changing the Paper Size or Type

Enlarging or reducing to the paper size ([Paper Size])

The original is printed after it is enlarged or reduced by a ratio that is automatically determined by the original size and paper size.

If you select a paper size larger than the original size, the original is enlarged to the paper size. If you select a paper size smaller than the original size, the original is
reduced to the paper size.

In [Paper Size] in the [Basic] tab, select the size of paper for printing. The zoom ratio is automatically determined by the paper sizes selected in [Original Size] and [Paper
Size].



This function is enabled when [Zoom] is set to [Auto].

Enlarging or reducing by the desired zoom ratio ([Zoom])

You can print the original image after it has been enlarged or reduced by the desired zoom ratio. The zoom ratio can be specified to be between 25% and 400% (in
increments of 1%).

In [Zoom] in the [Basic] tab, specify the zoom ratio. When specifying the common zoom ratio in the vertical and horizontal directions, select [Manual-lock aspect ratio], and
specify the zoom ratio. When specifying a different zoom ratio in the vertical and horizontal directions, select [Manual-var. aspect ratio], and specify the zoom ratio.



Printing on custom-size paper ([Original Size])

For originals with a special size, print them on custom sized paper.

In [Original Size] in the [Basic] tab, select [Custom Size].

In [Paper Size], select [Same as Original Size].



The [Custom Size] setting window appears.

Specify the length and width as desired, and click [OK].



For details on the trays into which you can load custom-size paper and the available range of sizes, refer to Here.

When you are using the PCL driver, you can register a custom size in the [Save Custom Size...] of the [Settings] tab. The registered paper size can be
selected from [Original Size] in the [Basic] tab. For details, refer to Here.

Specifying the paper type for printing ([Paper Type])

In [Paper Type] in the [Basic] tab, select the type of paper for printing.
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When [Paper Settings for Each Tray] is enabled in the [Settings] tab of the printer driver, select [Paper Settings for Each Tray...] in the [Basic] tab, and specify the paper
type for each tray.



Specifying the paper tray ([Paper Tray])

In [Paper Tray] in the [Basic] tab, select the paper tray for printing.



If you select [Auto], the paper tray for the paper you have selected in [Paper Size] is automatically selected.

Printing on paper in multiple trays ([Carbon Copy])

You can print the original on different sheets of paper loaded into multiple trays. Because you can obtain printing results that look like carbon-copied slips using the print
command once, this function is called Carbon Copy.

For example, by using the print command once, you can print a submission document on high-quality color paper loaded in Tray1 and print your copy on recycled paper
loaded in Tray2.

This function is useful when you want to create a submission document and its copy at one time.



In [Paper Tray] in the [Basic] tab, select the paper tray for printing the original.

You cannot select [Auto].

In the [Cover Mode] tab, select the [Carbon Copy] check box.



The [Carbon Copy Settings] window appears.

Specify the paper tray for carbon copies and output order, and click [OK].



Setting Description

[Original Copy] The paper tray for printing the original is displayed.

[Carbon Copy Tray] Select the paper tray for carbon copies. Select the check boxes for all paper trays to be used.

[Output Order]

Select the order of outputting carbon copies.

[Tray]: Carbon copies are printed in order of selected trays. When an original comprised of multiple pages is
printed, all pages are printed on paper from one tray, then the next tray is used.

[Page]: Carbon copies are printed page by page. When an original comprised of multiple pages is printed, each
page is printed on paper from all the selected trays.



If [Page] is selected in [Output Order], multiple copies cannot be printed.



Printing Multiple Sets of Copies

Specifying the number of copies ([Copies])

In [Copies] in the [Basic] tab, specify the number of copies you want to print.

Making a trial printing (Proof Print) (Here)

Printing by sets ([Collate]/[Offset])

Output paper by set when printing multiple sets of copies.
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When the [Collate] check box on the [Basic] tab is selected, copies are output separately in a set-by-set manner, for example, "Pages 1, 2, 3, 4, and 5", "Pages 1, 2, 3, 4,
and 5", and then "Pages 1, 2, 3, 4, and 5". When the [Offset] check box is selected, the output position is staggered one by one.



Saving the Number of Printed Sheets

Printing multiple pages on the same side of a single sheet ([Combination])

You can print multiple reduced size pages on the same side of a single sheet to reduce the number of pages to be printed.

In [Combination] in the [Layout] tab, select "N in 1". For example, when you select [9 in 1], every set of nine pages is reduced and printed on the same side of one sheet.

If necessary, click [Combination Details...] to set the page layout order and whether to input border lines between pages.



By using this function in combination with the 2-Sided Print function ([Print Type]: [2-Sided]), you can save more amount of paper.

Printing on both sides of paper ([2-Sided])

Setting Description

[Layout Order] Select the page layout order.

[Border]
Select this check box when you want to draw border lines between pages. In addition, select the type of border lines from
[Frame] and [Line].



By using both sides of paper for printing, you can reduce paper consumption by half.

In [Print Type] in the [Layout] tab, select [2-Sided]. [2-Sided] is specified by default.

If this function is combined with the Combine function ([Combination]: "N in 1"), you can save more amount of paper.



Skipping blank pages ([Skip Blank Pages])

Blank pages contained in the original are skipped when the original is printed. You can reduce the number of printed sheets.

In the [Layout] tab, select the [Skip Blank Pages] check box.



For some originals, blank pages are also printed.

[Skip Blank Pages] is available only when the printer driver for Windows is used.



Setting the Printout Finishing

Adding a margin on pages ([Binding Margin])

A margin for binding is added on pages.

In the [Layout] tab, select the [Binding Margin] check box.

In [Binding Position] in the [Layout] tab, specify the margin position.



Click [Binding Margin Settings...].

Adjust the size of margin and click [OK].

Setting Description

[Shift Mode] Select how the images are shifted for creating the margin.

[Front Side]/[Back Side]
Specify the size of the margin on the front side.
When you print on both sides, specify the size of the margin on the back side. When the [Same value for front and
back sides] check box is selected, a margin of the same size is created on both front and back sides.



[Binding Margin] is available only when the printer driver for Windows is used.

Stapling paper ([Staple])

Each set of sheets can be stapled (at a corner or at two positions) and output automatically. This function is useful for preparing a project proposal or other booklet
materials.

In the [Finish] tab, select the [Staple] check box. In addition, specify the number and positions of staples.



To use this function, an option is required. For details on the required option, refer to Here.

In [Binding Position] in the [Layout] tab, specify the staple position.

Binding in the center of the paper ([Center Staple and Fold])

The printed sheets are bound in the center and folded before they are output.
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In the [Finish] tab, select the [Center Staple and Fold] check box.

As the sheets are bound in the center, use the combined document data or set the [Print Type] to [Booklet] on the [Layout] tab.

To use this function, an option is required. For details on the required option, refer to Here.
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Punching the printed sheets ([Punch])

Printed sheets are punched for filing before they are output. This function is useful when you want to bind printed materials in files.

In the [Finish] tab, select the [Punch] check box. In addition, specify the number and positions of punch holes.



To use this function, an option is required. For details on the required option, refer to Here.

In [Binding Position] in the [Layout] tab, specify the punch position.

The number of punched holes varies depending on the area you are in.

Folding paper ([Fold])

The printed sheets are creased before they are output.

Half-Fold

Tri-Fold

Z-Fold

In the [Finish] tab, select the [Fold] check box, and select the folding mode.

When you want to fold page by page, specify the number of pages to be folded at one time in [Page Fold Setting].
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To use this function, an option is required. For details on the required option, refer to Here.

When using the Z-fold function, specify the paper size indicated in the setting value ([Z-Fold (A3, B4, 11 e 17, 8K)] or [Z-Fold (8 1/2 e 14)]), which you select
from the drop-down list, in "Paper Size" of the application software or printer driver.

This function cannot be used on originals that contain more pages than the number of pages that can be folded by this machine.

Printing in a booklet format ([Booklet])

The pages in the original data are arranged and spread out in booklet format and printed on both sides of sheets. When the printed sheets are stacked and folded in two,
the pages are arranged in the correct order.
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In [Print Type] in the [Layout] tab, select [Booklet].



When paper is folded as a booklet, the finishing size is half that of the paper size you selected in [Paper Size].

By selecting [Fold] or [Center Staple and Fold] in the [Finish] tab in combination with this function, you can create booklet-form documents by folding the
printed sheets in the center or by binding them using two staples in the center.

By selecting [Chapters] in the [Layout] tab in combination with this function, you can place the specified page on the front side.

Specifying the output tray ([Output Tray])

In [Output Tray] in the [Finish] tab, select the tray to which printed sheets are output.



Adjusting the Layout

Printing a poster-sized image ([Combination]) (PCL only)

The original image is enlarged, divided, and printed on multiple sheets. When you join the printed sheets together, a large poster is created.

In [Combination] in the [Layout] tab, select "N e N". For example, when you select [2 e 2], one page of the original image is enlarged, divided, and printed on four sheets.

As necessary, click [Combination Details...] to select whether to create overlap margins.



Rotating the image 180 degrees ([Rotate 180])

The image is printed upside down. Use this function when printing on envelopes whose loading direction cannot be changed.

In the [Layout] tab, select the [Rotate 180] check box.



Click [180 Degree Rotation Setting...].

Specify the original to rotate at 180 degrees, then click [OK].



The size and orientation of the original to be rotated 180 degrees depend on those of the original recognized by the application.



Fine-tuning the print position ([Image Shift])

You can fine tune the image position by shifting it in a horizontal or vertical direction according to the paper size. When an image is printed on the back side, you can also
fine tune its position.

Use this function when you want to make a fine adjustment, such as changing the print position a little or printing images in different positions between the front and back
sides.

In the [Layout] tab, select the [Image Shift] check box.



Click [Image Shift Settings...].

Adjust the upward/downward and rightward/leftward shift distances, and click [OK].

When printing images on both sides, selecting the [Same value for Front and Back sides] check box applies the same settings to both sides.



Adding Text or an Image to the Original

Adding a watermark ([Watermark])

Text such as "NO REPRODUCTION" and "INTERNAL USE" are printed on the center of all pages in a tint color.

By printing a watermark, you can specify the handling policy of copied documents.

In the [Stamp/Composition] tab, select the [Watermark] check box. In addition, select the watermark you want to print.



[Watermark] is available only when the printer driver for Windows is used.

Registering/editing a watermark

This machine has several factory-set watermarks. However, you can register new watermarks or edit existing watermarks as necessary.

In the [Stamp/Composition] tab, select the [Watermark] check box, and click [Edit].



Click [Add] and register the watermark data.

To edit a registered watermark, select the watermark from the [Current Watermark] list, and edit the data.

To delete a registered watermark, select the watermark from the [Current Watermark] list, and click [Delete].

Setting Description

[Watermark Name] Enter the name to be displayed in the watermark list (using up to 30 characters).

[Watermark Text] Enter the text to be displayed as a watermark (using up to 30 characters).

[Up]/[Down]
Clicking these buttons changes the order of items in the list. You can move frequently used watermarks to upper
positions.

[Position] Specify the print position for the watermark.



Click [OK].

Composing an overlay image ([Overlay])

An overlay image registered in the computer or this machine is recalled and printed on the original as a composite image.

For details on how to register an overlay image on your computer, refer to Here.

For details on how to register an overlay image in a shared folder on the network, refer to Here.

For details on how to register an overlay image in this machine, refer to Here.

[X]/[Y]: Adjust the horizontal and vertical positions of the watermark. The values change as you move the slide
bar.

[Center]: Click this button to reset the watermark position to the center.

[Angle]: Adjust the angle of the watermark.

[Font Name] Select the font for the watermark.

[Size] Specify the font size for the watermark.

[Style] Select the font style for the watermark.

[Frame] Select the frame for the watermark.

[Text Color] Select the color of the watermark.

[Transparent]
Select this check box to print the watermark in a translucent tone.
When this check box is cleared, the printed watermark obscures the background.

[1st Page Only] Select this check box to print the watermark only on the first page of the original.

[Repeat] Select this check box to repeatedly print the watermark on each page.

[Sharing] Select this check box to share the watermark with other users.
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In [Overlay] in the [Stamp/Composition] tab, select [Print Host Image] or [Print Device Image] (PCL only), and then from the list, select the overlay image to be printed on
the original as a composite image.

As necessary, click [Edit...] to add or delete overlay images. Alternatively, change the method of composing an overlay image.

When you have selected [Print Host Image]:



Setting Description

[Select Overlay File] Add or delete overlay images.

[Browse Files...] Add an overlay image to the list.

[Delete] The selected overlay images are deleted from the list.



When you have selected [Print Device Image]:

[Change 2nd Page and Later]
Select this check box to change the overlay image to be printed on the second and subsequent pages of the original. In
addition, from the list, select the overlay image you want to use.

[File Information] Information on the selected overlay image is displayed.

[Overlay Print Setting] If necessary, change the method of composing an overlay image.

[Pages] Select the range of pages on which an overlay image is composed.

[Overwrite]
Select whether to compose the overlay image by overwriting the image on the front side of the original, or to composite it on
the back side of the original.



Setting Description

[Obtain Device Information]
If your computer can communicate with this machine, your computer obtains and displays the latest information on the
overlay images registered in this machine.



[Overlay] is only available when the printer driver for Windows is used.

Creating an overlay image in the computer

In your computer, you can create an image that is composed on the original from [Overlay] in the [Stamp/Composition] tab. For example, you can register a corporate
letterhead or other forms for use as a composite image on the original.

In application software, create an original to be registered in an overlay image.

In [Overlay] in the [Stamp/Composition] tab, select [Create Host Image].

[Overlay Info] Information on the overlay image selected from the list is displayed.

[Print on Front Side]/[Print on Back
Side]

Select this check box to compose an overlay image on the front and back sides. In addition, specify how to compose an
overlay image.

[Overlay Name]
Select the overlay image to be composed.

Click [Browse...] to confirm the detailed overlay information.

[Select Color] Select the color of the overlay image to be composed.

[Density] Specify the density of the overlay image to be composed.

[Overwrite]
Select whether to compose the overlay image by overwriting the image on the front side of the original, or to compose it on
the back side of the original by watermarking the image.

[Same as Front Side] Select this check box to apply the settings for the front side to the back side.

[Pages] Select the range of pages on which an overlay image is composed.



In the application software, execute printing.
The [Create Overlay File] window appears.

Enter the file name and save the file.
The overlay image is saved on your computer. From then on, when you select [Print Host Image] in [Overlay] in the [Stamp/Composition] tab, the saved overlay
image is displayed in the list and is also available.

Creating an overlay image in a shared folder



In a shared folder, you can create an image that is composed on the original from [Overlay] in the [Stamp/Composition] tab. The created overlay image can be shared by
other users.

First, in the [Settings] tab, register a shared folder for storing the overlay image.

Display the [Properties] window of the printer driver.

For information on how to display the [Properties] window, refer to Here.

In the [Settings] tab, select the [Share Overlay File(s)] check box.

The [Shared Folder Settings] window appears.
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Specify the shared folder for storing the overlay image, and click [OK].
This completes the registration process of a shared folder. Then, create an overlay image.

In application software, create an original to be registered in an overlay image.

In [Overlay] in the [Stamp/Composition] tab, select [Create Shared Folder Image].

In the application software, execute printing.
The [Create Overlay File] window appears.



Enter the file name and save the file.
The overlay image is saved in the shared folder. From then on, when you select [Print Host Image] in [Overlay] in the [Stamp/Composition] tab, the saved overlay
image is displayed in the list and is also available.

Adding the print date/time or page number ([Date/Time]/[Page Number])

You can add the print date/time or page number to your printouts. If necessary, you can select the print position and format of the text.

Date/Time

Page Number

In the [Stamp/Composition] tab, select the [Date/Time] or [Page Number] check box.



As necessary, click [Edit...] to change the print position and format of the text.



Setting Description

[Date/Time] Change the print position or format of the date/time.

[Format] As necessary, click [Edit...] to specify the date/time format or whether to print the time.

[Pages] Specify the range of pages on which the date/time is printed.

[Text Color] Select the print color for the date/time.

[Print Position] Specify the print position for the date/time.

[Page Number] Change the print position of page numbers and the page from which the page number printing starts.

[Starting Page] Specify the page from which the page number printing starts.



Adding information to the header/footer ([Header/Footer])

You can add and print the date and time and arbitrary text in the top or bottom margin (header/footer) of the original. You must register the information to be added for the
header and footer in advance on this machine. For details on the registration procedure, refer to Here.

In the [Stamp/Composition] tab, select the [Header/Footer] check box. In addition, select the information you want to add to the header/footer.

[Starting Page Number] Specify the page number to be printed on the page specified in [Starting Page].

[Cover Mode]
Select this check box to print page numbers on the front and back covers when they are inserted. In addition, select the
format.

[Text Color] Select the print color for the page numbers.

[Print Position] Specify the print position for the page numbers.
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As necessary, click [Edit...] to change the range of pages on which the header/footer is printed and other settings.



Setting Description

[Recall Header/Footer]
Select the header/footer to be recalled.
If your computer can communicate with this machine, clicking [Obtain Device Information] obtains and displays the latest
header/footer information registered in this machine.

[Distribution Control Number] Select whether to print copy numbers when printing multiple sets of copies.
[Print in Header]: Select this check box to print the copy number in the header.

[Print in Footer]: Select this check box to print the copy number in the footer.



As necessary, click [Edit...] to specify the copy number format and the page from which the copy number printing starts.

[Pages] Select the range of pages on which the text is printed in the header/footer.

[Text Color] Select the color of the text to be added to the header/footer.



Deterring Unauthorized Copying

Printing a concealed security watermark ([Copy Protect])

Text such as "Copy" and "Private" are printed in the background pattern as concealed text. This function is called the Copy Protect function.

When a copy-protected document is copied, the concealed security watermark appears on the entire page, thereby indicating that it is an unauthorized copy.

In the [Stamp/Composition] tab, select the [Copy Security] check box, and then select [Copy Protect].

As necessary, click [Edit...] to specify the text to be printed and the format of the text. For details, refer to Here.
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Printing a stamp on the entire page ([Stamp Repeat])

Print a stamp such as "Copy" or "Private" on the entire page.

By printing text such as "Copy" or "Private" as a visible stamp, you can deter unauthorized copying.

In the [Stamp/Composition] tab, select the [Copy Security] check box, and then select [Stamp Repeat].

As necessary, click [Edit...] to specify the text to be printed and the format of the text. For details, refer to Here.

Adding copy restriction information ([Copy Guard])
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Copy Guard is a copy protection function that prints concealed security watermarks such as "Private" or a date in the background to prevent unauthorized copying, and
embeds a copy restriction pattern on all printed sheets.

If an attempt is made using a device that supports the copy guard function to copy a sheet that has been copy protected, a copy guard pattern is scanned, the copying
process is canceled, and the job is deleted.

In the [Stamp/Composition] tab, select the [Copy Security] check box, and then select [Copy Guard].

As necessary, click [Edit...] to specify the text to be printed and the format of the text. For details, refer to Here.
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To use this function, an option is required. For details on the required option, refer to Here.

To use this function, select [Copy Security] (Here), and set [Copy Guard] to ON.

Adding a password ([Password Copy])

Password Copy is a copy protection function that prints concealed security watermarks such as "Private" or a date in the background to prevent unauthorized copying, and
embeds a password for the password copy function on all printed sheets.

If an attempt is made using a device that supports the password copy function to copy a sheet that has been prepared for password copy, a password copy pattern is
scanned and entry of a password is requested. Copying starts if the correct password is entered.

In the [Stamp/Composition] tab, select the [Copy Security] check box, and then select [Password Copy].
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Enter the password to be embedded (using up to eight characters), and then click [OK].

As necessary, specify the text to be printed and the format of the text. For details, refer to Here.
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To use this function, an option is required. For details on the required option, refer to Here.

To use this function, select [Copy Security] (Here), and set [Password Copy] to ON.

Configuring the print settings for Copy Security

When printing a copy security pattern on sheets, you can set the text to be printed and the format of the text as necessary.

In the [Stamp/Composition] tab, check the [Copy Security] box, and then click [Edit...].
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In the [Print Item] tab, select the item to be printed.

Items that can be specified vary depending on the selected copy security function.

Setting Description

[Characters] Select this check box to print a text. In addition, select the text you want to print.

You can select the text to be printed from the registered preset stamps and stamps registered by users.



In the [Detail Settings] tab, set the print format.

Items that can be specified vary depending on the selected copy security function.

If your computer can communicate with this machine, clicking [Obtain Device Information] obtains and displays
the latest stamp information registered in this machine.

[Date/Time]
Select this check box to add the print date/time.
As necessary, click [Edit...] to specify the format.

[Serial Number] Select this check box to print the serial number of this machine.

[Distribution Control Number]
Select this check box to print copy numbers when printing multiple sets of copies.
As necessary, click [Edit...] to specify the start number and the number of digits.

[Job Number] Select this check box to print the job numbers managed in this machine.



Setting Description

[Angle] Select the angle of the text to be printed.

[Text Size] Select the size of the text to be printed.

[Pattern Color]
Select the color of the copy security pattern.
As necessary, click [Adjust Color...] to adjust the density and contrast.

[Pattern Overwrite] Select whether to compose the copy security pattern on the front or back side of the original.

[Background Pattern] Select the copy security pattern from the background patterns registered in this machine.

[Pattern] Select whether the text pattern is embossed or outlined when the original is subjected to unauthorized copying.



Click [OK].



Inserting Paper into the Original

Inserting front and back covers ([Front Cover]/[Back Cover])

You can insert a cover sheet before the first page or after the last page of the text.

The front and rear cover sheets can be a paper different from body pages (in paper color and thickness). You can print them at a time.

In [Paper Tray] in the [Basic] tab, select the paper tray for printing the body pages.

You cannot select [Auto].



In the [Cover Mode] tab, select the [Front Cover] or [Back Cover] check box.

If necessary, you can select whether to print the original on the inserted sheets or to leave them blank. When the inserted sheets are printed, the first page of
the original is printed on the front cover and the last page of the original is printed on the back cover.

In [Front Cover Tray] or [Back Cover Tray], select the paper tray for the paper to be used as the front cover or the back cover.



Inserting front and back covers ([Front Cover from Post Inserter]/[Back Cover from Post Inserter])

You can insert the optional Post Inserter paper before the first page or after the last page of the original as the outer front cover.

In [Paper Tray] in the [Basic] tab, select the paper tray for printing the body pages.

You cannot select [Auto].



In the [Cover Mode] tab, select the [Front Cover from Post Inserter] or [Back Cover from Post Inserter]
check box.

Select the PI tray for the paper to insert as the front and back covers.



Inserting paper between transparencies ([Transparency Interleave])

When printing on multiple transparencies, you can insert the specified paper between the transparencies. These sheets of paper prevent the transparencies from sticking
together due to heat generated during printing or static electricity.

In [Paper Type] in the [Basic] tab, select [Transparency].



If you select [Transparency], the [Print Type] is set to [1-Sided], and the [Select Color] is set to [Gray Scale].

In the [Cover Mode] tab, select the [Transparency Interleave] check box.

In [Interleave Tray], select the paper tray for the paper to be inserted between transparencies.

Transparency Interleaves are inserted as blank sheets.



Inserting paper into the specified pages ([Per Page Setting])

Paper different from other pages is inserted into the specified pages.

You can insert a color paper and a thick paper. You can also select whether to print the original on the inserted paper.

Create in advance a list that specifies the paper and print settings for each page. When printing on inserted paper, select the list you want to apply to printing.



In the [Cover Mode] tab, select the [Per Page Setting] check box, then click [Edit List...].

When you have already prepared a list, select the list you want to apply to printing.

Create a list by specifying the paper and print settings for each page.



Setting Description

[Settings List] The settings for each page are displayed in a list.

[List Name] Select the list to be created.

[Edit List Name] If necessary, change the list name.

[Up]/[Down] These buttons move the order of settings in the list. They do not change the settings.

[Add] This button adds the setting to the list.

[Delete] This button deletes the setting selected in the list.

[Add/Edit] You can add settings to the [Settings List] or edit settings.

[Page Number]
Enter the page numbers you want to add.
To specify multiple page numbers, separate each number with a comma (for example, "2,4,6") or connect the numbers
using a hyphen (for example, "6-10").

[Change Settings] Change the setting for the item selected in the [Add/Edit] list.

[Print Type]: Select the print type applied when printing the specified pages.

[Paper Tray]: Select the paper tray for printing the specified pages.

[Staple]: Select the staple position applied when the specified pages are stapled.



Click [OK].



Specifying the Color and Image Quality

Selecting colors for printing ([Select Color])

Select colors for printing. There are five color modes: [Auto Color] that fits the original color, [Full Color], [Gray Scale], [2 Color (Text Priority)], and [2 Color (Photo Priority)].

In [Select Color] in the [Quality] tab, select a color mode for printing.



[Full Color] is a function of the PS driver.

[2 Color (Text Priority)] and [2 Color (Photo Priority)] are functions of the PCL driver.

Fine-tuning the image quality according to the original ([Quality Adjustment])

You can fine tune the color image quality according to the original. For example, you can increase the vividness or reduce the color difference.

You can adjust the overall image quality of the original, and you can also adjust in detail the image quality of each element of the original, such as text and photos. When
you are using the PCL driver, you can adjust the brightness and contrast.

In the [Quality] tab, click [Quality Adjustment].



Fine tune the image quality according to the original.

[Simple]: The image quality of the entire original is adjusted. Specify the type of the color profile used for printing.

[Detail]: The image quality of the original is adjusted in detail for each element such as text, photos, figures, tables, and graphs. For each element, specify the

type of the color profile used for printing and other profiles to be applied.



Click [OK].



Using ICC Profiles (PS Only) (Here)

[Quality Adjustment] is available only when the printer driver for Windows is used.

Selecting the optimum color representation for the original ([Image Quality Setting])

Select the optimum settings for the original to print it at the optimum image quality level.

Select one of the following processes according to the original to be printed; the process suitable for originals consisting primarily of text, the process suitable for photos,
the process suitable for originals created with DTP, or the process suitable for printing CAD data.

In [Image Quality Setting] of the [Quality] tab, select the image setting mode to suit the original.
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Specifying the graphic pattern density ([Pattern]) (PCL only)

In [Pattern] in the [Quality] tab, select the graphic pattern density.



[Pattern] is available only when the printer driver for Windows (PCL) is used.

Specifying the compression ratio of graphic images ([Image Compression]) (PCL only)

In [Image Compression] in the [Quality] tab, select whether the quality or printing speed is preferred when the image data contained in the original is compressed.



[Image Compression] is available only when the printer driver for Windows (PCL) is used.

Making the image glossy ([Glossy Mode])

Images are printed with a glossy finish.



In the [Quality] tab, select the [Glossy Mode] check box.

This function is enabled when [Print Type] is set to [1-Sided].

Preventing the generation of white space around images ([Auto Trapping]/[Black Over Print] (PS only))

The generation of white space on the boundary between different colors or around characters is prevented.



In the [Quality] tab, select the [Auto Trapping] check box or configure the [Black Over Print] setting.

Select the [Auto Trapping] check box to superimpose neighboring colors to print so as to prevent generation of white space around a picture.

Select the [Black Over Print] check box to superimpose black color on a neighboring color to print so as to prevent generation of white space around black
characters or figures. You can select whether to print black only around the characters or around both characters and figures.

Saving toner ([Toner Save])



Selecting the [Toner Save] check box in the [Quality] tab adjusts the printing density in order to save the amount of toner consumed.

Sharpening the border between text etc. ([Edge Enhancement])

Sharpen the edges of images such as text in the table and graphics to improve legibility.

In [Edge Enhancement] of the [Quality] tab, select the level to highlight.



Specifying font processing ([Font Settings])

Specify how the fonts are processed for printing.

In the [Quality] tab, click [Font Settings].



Change how the fonts are processed for printing.

PCL driver



PS driver



Click [OK].

If characters are garbled in an environment using the PCL driver, we recommend that you select [Bitmap] in [Download Font Format] and clear the [Use
Printer Fonts] check box.

[Font Settings] is available only for the Windows printer driver.

Preventing failure in printing thin lines ([Thin Line Support]) (PCL only)

Select this option to prevent thin lines from disappearing in reduced-size printing.

In the [Other] tab, select the [Thin Line Support] check box.

Setting Description

[Download Font Format] Select a type of fonts to be downloaded from the PC to this machine.

[Use Printer Fonts]
Select this check box to replace TrueType fonts with printer fonts during printing. Use of printer fonts increases the
printing speed.
In normal printing operations, we recommend that you select this check box.

[TrueType Font Substitution Table]
(PCL only)

Set this table when you want to specify the printer fonts that replace TrueType fonts.
From the list, select the TrueType font, then in [Printer Font to Use], select the printer font with which you want to
replace the TrueType font.



This is effective for thin lines such as table borders created in Excel, but not for thin lines used in illustrations.

[Thin Line Support] is only available only for the Windows printer driver (PCL).

Convert colors according to the RGB values of the original ([Convert to Gray Scale]) (PCL only)

When you open the [Quality] tab and set the [Select Color] to [Auto Color], the image is automatically converted into gray scale and printed if the RGB values of the original
are below the thresholds you have set.

In the [Other] tab, check the [Convert to Gray Scale] box and set the threshold (the differential RGB values to be converted into gray scale).



[Convert to Gray Scale] is available only for the Windows printer driver (PCL).



Using ICC Profiles (PS Only)

Specifying the ICC profiles for printing

Specify and print the ICC profiles registered in this machine with the printer driver.

To use the new ICC profiles registered this machine, you need to add the ICC profiles to the printer driver in advance. For details, refer to Here.

In the [Quality] tab, click [Quality Adjustment...].

Click [Detail] and select the element for which the image quality is adjusted.

Click the [ICC Profile] tab.
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Specify the settings for [RGB Color], [Destination Profile], and [Simulation Profile].

The ICC profiles registered in the printer driver can be selected.

Click [OK].



Color processing is performed according to the selected ICC profiles.

Adding ICC profiles to the printer driver

To use the ICC profiles registered in this machine for printing, you need to add the ICC profiles to the printer driver in advance.

This function is available if the computer can communicate with this machine. The computer communicates with this machine and loads ICC profiles that the machine
can use.

This function cannot be used when this machine is used via a USB connection.

To register ICC profiles in this machine, use Download Manager. For details on how to register ICC profiles in this machine, refer to the Help for Download
Manager.

In the [Quality] tab, click [Quality Adjustment...].

Click [Manage Profile].

When the Download Manager has been installed, if you click [Download Manager], Download Manager starts.



Click the tab and select a color profile type.



From the [Available Profile] list, select the profile you want to add to the printer driver, then click [Add Sel].

To register the current driver settings as the profile, click [New], then enter the [File Name] and [Profile Name].

To edit the profile name, click [Edit].



Click [OK].
The profile is added to [Driver Profile List].



Printing Microsoft Excel/PowerPoint Data

Printing multiple Excel sheets at one time

When multiple Microsoft Excel sheets with different print settings are printed at one time, this function prevents the sheets from being printed separately.

In the [Other] tab, check the [Excel Job Control] box.

[Excel Job Control] is only available when the printer driver for Windows is used. However, this function is not available when you are using 32-bit application
software in the 64-bit operating system.



Composing and printing an image correctly in PowerPoint

The process executed when an overlay image is printed on a PowerPoint original with a white background is optimized. This function prevents the overlay image from
being overwritten by the white background of the PowerPoint original.

In the [Other] tab, select the [Remove White Background] check box.

[Remove White Background] is only available only for the Windows printer driver. However, this function is not available when you are using 32-bit
application software in the 64-bit operating system.



Making a Trial Printing ([Proof Print])

About Proof Print

The Proof Print function is used when printing multiple copies. It allows the printer to output one copy and pause the printing operation before printing the remaining copies.

Because you can check the print result before starting printing the remaining copies, this function is helpful to prevent a lot of misprints.

Setting Proof Print on your computer

In [Output Method] in the [Basic] tab, select [Proof Print].



Specify the number of copies, then execute printing.
Only one copy is printed. Then, proceed to "Printing a Proof Print job on this machine".

Printing a Proof Print job on this machine

Tap [Job List] on the home screen.

While [Active] is displayed, tap [Release Held Jobs].



Select the job you want to print.



If necessary, tap [Change Setting] to change the print conditions.

To delete a job, tap [Delete].

Tap [Start].
The remaining copies are printed.

Deleting a Proof Print job

A job, which has been sent to this machine with [Proof Print] enabled, can be deleted remotely using Web Connection via the Web browser of the computer.

Access to Web Connection using the Web browser.

For details on how to access, refer to Here.

Log in to the user mode.

For details on how to login to the user mode, refer to Here.

Click [Job] - [Current Jobs].

Click [Release Job].
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Select the check box of the job to be deleted, and click [Delete].

Click [OK].
The selected job is deleted.



Printing Highly Confidential Documents ([Secure Print])

About Secure Print

Secure Print is a function that assigns document ID and password to print data and saves the data to the Secure Print User Box of this machine. This function does not
print data immediately, thereby preventing printed materials from being missing or left.

You need to enter the document ID and password on the screen of this machine to print the data saved in a User Box. Therefore, this function is particularly suitable for
safely printing highly confidential documents.

[Secure Print Only] (Here)

Enabling simple printing for secure print document (for the administrator)

If simple printing for secure print document is enabled, the computer login name is used as the document ID for Secure Print, so you can skip the entry of the document ID.

Also, if the computer login name is used as the document ID for Secure Print, it prevents the document ID from being duplicated with that of another user, which simplifies
document management on this machine.

When making prints on the machine, the user can display a list of document IDs on the screen of this machine and easily specify the target document ID.

To enable simple printing of secure documents, configure the following settings.

Enable simple printing of secure documents on this machine (default: [Do Not Release Secure Print]). For details on the setting procedure, refer to Here.

In [Device Option] of the [Configure] tab on the printer drive, set [Security Document Setting] to [Release Secure Print] (default: [Do Not Release Secure Print]). For
details on [Device Option], refer to Here.
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When simple printing is disabled, the document ID can be specified using up to 16 characters. If simple printing is enabled, the document ID can be
extended to up to 64 characters.

If simple printing is changed from Enable to Disable while the document ID is specified using 17 or more characters, it will cause document operations to fail.

Setting Secure Print on your computer

A single job enables you to print out a document of up to 2999 pages in length.

In [Output Method] in the [Basic] tab, select [Secure Print].



Enter the document ID and password, then click [OK].

If you always use the same document ID and password, registering them in advance eliminates the need to enter them each time. For details, refer to Here.

Execute printing.
The data is saved in the Secure Print User Box. Then, proceed to "Printing a Secure Print job on this machine".

You can issue a print instruction from the screen of this machine before print data scanning on this machine is completed. However, printing is executed after

print data scanning on this machine has been completed.

https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id01-_104515008.html#id01-_104515010


Printing a Secure Print job on this machine

Data printed using the Secure Print function is saved in the Secure Print User Box. To print the saved data, you need to enter the document ID and password specified in
the printer driver.

For details on the printing procedure, refer to Here.

[Delete Secure Print File] (Here)

[Delete Time Setting] - [Auto Delete Secure Document] (Here)
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Saving an original in a User Box of this machine ([Save in User Box])

About Save in User Box

The Save in User Box function saves print data in a User Box on this machine. You can also print the data at the same time as it is being saved in the box.

You can use multiple User Boxes for different purposes, for example:

By saving data in a User Box that all users can access (Public Box) or in a User Box that the members of a specific department can access (Group Box), you can
distribute the data.

By saving data in the private box (Personal Box), you can assure security because only you can open the box. The data in the box is not deleted by mistake.

Registering a User Box on this machine

Register the boxes for storing print data on this machine.

For information on how to register a User Box, refer to Here.

Registering a User Box (Web Connection) (Here)

Setting Save in User Box on your computer
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In [Output Method] in the [Basic] tab, select [Save in User Box].

When you want to print the data at the same time it is saved in the box, select [Save in User Box and Print].

Enter the file name and the box number of the save location, click [OK].

Use a file name that helps you locate the data in the box.

The box number can be checked in the [User Box Information] list. Clicking [Obtain Device Information] obtains the latest information of the box registered in
this machine and displays it in the [User Box Information] list.



If you always use the same file name and box number, registering them in advance eliminates the need to enter them each time. For details, refer to Here.

Execute printing.
The data is saved in the box on this machine.
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[Obtain Device Information] cannot be used when this machine is used via a USB connection.

Using data in a User Box on this machine

You can print or send data saved in a User Box via E-mail or fax.

For information on how to print data saved in a User Box, refer to Here.

For information on how to send data saved in a User Box, refer to Here.

If data is saved in a User Box while [Resolution] in the [Quality] tab is set to [1200dpi (Rasterize on Device)], it cannot be sent. To send such data, set it to
[600dpi].
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Attaching Authentication Information

About printing with authentication enabled

When printing a document in an environment where user authentication or account track is employed, you need to send the authentication information (user name and
password) to this machine to execute printing. This requirement limits the users who can use this machine, preventing unauthorized use by a third party.

When this machine receives a print job from a user who is not allowed to print or a print job without authentication information, this machine automatically discards the job.

A print job without authentication information refers to a print job that is directly sent to this machine from an enterprise system such as ERP (Enterprise
Resource Planning) or a print job that is sent without correctly configuring the User Authentication/Account Track setting using the printer driver.

By default, the printing of a job without authentication information is prohibited. To permit printing, the appropriate setting is required in [Print without
Authentication] (Here). If printing is permitted, the unregistered user or account can execute printing even despite the intention of the administrator. If there is
any problem on security or management, you should not change the initial settings.

Printing Simultaneously with Authentication on this Machine (ID & Print) (Here)

Printing with authentication by user name only (quick authentication) (Here)

Enabling user authentication or account track on the printer driver
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In the [Configure] tab of the printer driver, check that the User Authentication/Account Track setting is correctly configured.

Display the [Properties] window of the printer driver.

For information on how to display the [Properties] window, refer to Here.

In [Device Option] in the [Configure] tab, check that the User Authentication/Account Track setting is
correctly configured for your operating environment.

If it is not configured correctly, select [User Authentication] or [Account Track] from the list, then change the relevant setting in [Setting].

https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id01-_104515131.html#id01-_104515132


Click [OK].

Setting authentication information on your computer

In the [Basic] tab, click [Authentication/Account Track...].

When user authentication is enabled, select [Recipient User], then enter the user name and password.

When this machine is accessible to public users (unregistered users), selecting [Public User] enables you to execute printing without entering the user name

and password.



When an external authentication server is used, click [Server Setting...] and select the authentication server.

The login name in the PC is displayed in the [User Name] field.

If you always use the same user name and password, registering them in advance eliminates the need to enter them each time. For details, refer to Here.

If account track is enabled, enter the account name and password.

If you always use the same account name and password, registering them in advance eliminates the need to enter them each time. For details, refer to Here.
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Click [OK].

If your computer can communicate with this machine, clicking [Verify] executes authentication based on the authentication information that has been input.
You can check the authentication information for errors before starting printing.

To perform MFP authentication when external server authentication is used together, select the [MFP
Authentication] check box in the [Other] tab.

Execute printing.
Printing starts successfully when the authentication information is judged to be correct.



Printing Simultaneously with Authentication on this Machine ([ID&Print])

About ID & Print

ID & Print is a function that saves print data to the ID & Print User Box of this machine when user authentication is installed. This function does not print data immediately,
thereby preventing printed materials from being missing or left.

You need to perform user authentication on this machine to print the data saved in the User Box. Therefore, this function is suitable for safely printing highly confidential
documents. When authentication succeeds, the print data of the login user is automatically printed. This enhances security as well as ensures smooth operation.

[Administrative Setting] - [ID & Print] (Here)

[Delete Time Setting] - [ID & Print Delete Time] (Here)

[ID & Print Delete Time] (Here)

Setting ID & Print on your computer

A single job enables you to print out a document of up to 2999 pages in length.

In the [Basic] tab, click [Authentication/Account Track...].
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Enter the authentication information, and click [OK].

The login name in the PC is displayed in the [User Name] field.

For details, refer to Here.
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In [Output Method], select [ID&Print].



Execute printing.
The data is saved in the ID & Print User Box. Then, proceed to "Printing an ID & Print job on this machine".

You can issue a print instruction from the screen of this machine before print data scanning on this machine is completed. However, printing is executed after
print data scanning on this machine has been completed.

Printing an ID & Print job on this machine (when printing all jobs)

Enter the user name and password.



Check that [Logout after Print] is selected in [ID & Print], and tap [Login].

Selecting [Logout after Print] automatically logs out after data printing.

Selecting [Login without Print] logs out without printing data. You can open ID & Print User Box in User Box mode, and print only the specific data in the User

Box. For details, refer to Here.

Selecting [Login after Print] logs in after data printing. [Login after Print] is displayed when [Change to Basic Screen after ID & Print] (Here) is set to [ON].

When you are successfully authenticated, all data items saved in the ID & Print User Box are printed.

Printing an ID & Print job on this machine (when printing a specific job)

This section describes how to select and print a file from the ID & Print User Box.

Enter the user name and password.
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In [ID & Print], select [Login without Print].

Tap [Login].

Tap [ID & Print] on the home screen.



Tap the file to be printed.

Tapping the setting icon in the upper-right side allows you to change any print setting.

Use the Start key to start printing.

Printing an ID & Print job on this machine (with Authentication Unit used)

You can make prints easily by performing authentication using the Authentication Unit.

Check that [Authentication Device] is selected in [Authentication Method].

Check that [Logout after Print] is selected in [ID & Print], and select Authentication Unit.



Selecting [Logout after Print] automatically logs out after data printing.

Selecting [Login without Print] logs out without printing data. You can open ID & Print User Box in User Box mode, and print only the specific data in the User
Box. For details, refer to Here.

Selecting [Login after Print] logs in after data printing. [Login after Print] is displayed when [Change to Basic Screen after ID & Print] (Here) is set to [ON].

When you are successfully authenticated, all data items saved in the ID & Print User Box are printed.

[Administrative Setting] - [ID & Print Operation Settings] (Here)
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Printing in the Single Sign-on Environment of Active Directory

About single sign-on

When the print service of this machine joins a domain of Active Directory, users can execute printing from computers in the same domain without entering the
authentication information (user name and password). The authentication information entered in the login page on the computer is used for this authentication.

Enabling single sign-on in the printer driver

In the [Configure] tab of the printer driver, check that the User Authentication and Single sign-on settings are correctly configured.

Before using this function, configure a setting to join this machine in the Active Directory domain. For details, refer to Here.

Display the [Properties] window of the printer driver.

For information on how to display the [Properties] window, refer to Here.

In [Device Option] in the [Configure] tab, check that the [User Authentication] and [Single Sign-On] settings
are correctly configured for your operating environment.

If they are not configured correctly, select [User Authentication] and [Single Sign-On] from the list, and then change the relevant settings in [Setting].

You can set the [Single Sign-On] option to [Enable] if you have set the [User Authentication] to [ON (External Server)] or [ON (MFP) + ON (External Server)].
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Setting single sign-on on your computer

In the [Basic] tab, click [Authentication/Account Track...].



Check [Enable Single Sign-On functionality for printing functions] box, and click [OK].

The login name in the PC is displayed in the [User Name] field.



Click [OK].

Execute printing.
Printing starts.



Printing on Banner Paper

About printing on banner paper

This machine accommodates paper with a length of up to 47-1/4 inches (1200 mm) in the Bypass Tray.

Printable paper

How to print on banner paper

Specify the banner paper size.

On the screen of this machine, tap [Utility] - [Banner Printing].

Select [Allow], and tap [OK].

Paper width Paper length Paper weight

3-9/16 to 11-11/16 inches (90
mm to 297 mm)

18 to 47-1/4 inches (457.3 mm
to 1200 mm)

33-13/16 to 55-7/8 lb (127 g/m2 to 210 g/m2)

Using the printer driver, select the paper type appropriate for the weight of the banner paper to be
used.

32-3/16 to 41-3/4 lb (121 g/m2 to 157 g/m2): Thick 1+, Thick 1+ (Side 2)

42 to 55-5/8 lb (158 g/m2 to 209 g/m2): Thick 2, Thick 2 (Side 2)

55-7/8 lb (210 g/m2): Thick 3, Thick 3 (Side 2)



Check that the system is changed to the banner print job wait state.

When you have finished the above settings, start to print from the PC.

In [Original Size] in the [Basic] tab, select [Custom Size].



Specify the length and width of the banner paper, and click [OK].



The [Confirm setting changes] dialog box appears.

Click [Yes].
The [Paper Tray], [Paper Type], and [Print Type] settings are switched.

Change the setting of [Paper Type] for Bypass Tray according to the weight of print paper.

If [Resolution] is set to [1200dpi (Rasterize on Device)], it is switched to [600dpi].

Execute printing.
A message that prompts you to load paper is displayed on the screen of this machine.

Load the banner paper into the Bypass Tray.

For information on how to load banner paper into the Bypass Tray, refer to Here.
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When you have loaded a banner paper, tap [Complete].

Printing on the banner paper starts. Support the ejected banner paper by hand. To continue printing, execute printing from the computer.

Tap [Exit].
A message confirming the end of banner printing is displayed. To terminate printing, tap [Yes].

If there is a queued job, the job is started.



Specifying the Resolution for Printing ([Resolution])

Open the file in the application, and click [File]. Then click [Print] from the menu.

Select this product from [Select Printer] (or [Printer Name]), and click [Preferences] (or [Properties]).

In [Resolution] on the [Quality] tab, select the type of the document to print.

Click [OK].



Click [Print].



Skipping Blank Pages for Printing ([Skip Blank Pages])

Open the file in the application, and click [File]. Then click [Print] from the menu.

Select this product from [Select Printer] (or [Printer Name]), and click [Preferences] (or [Properties]).

In the [Layout] tab, select the [Skip Blank Pages] check box.

Click [OK].



Click [Print].



Printing on Envelopes or Postcards

Execute a print job on your computer then load envelopes or postcards into this machine to execute a print job on it.

The following explains how to print on standard-size envelopes or postcards loaded into the Bypass Tray.

Open the file in the application, and click [File]. Then click [Print] from the menu.

Select this product from [Select Printer] (or [Printer Name]), and click [Preferences] (or [Properties]).

In [Original Size] on the [Basic] tab, select [Envelope] or [Postcard].

Various sizes of envelopes are available. Select the correct paper size for the envelopes you have loaded.

If [Postcard] is selected, [Paper Type] is automatically set to [Thick 3]. If [Envelope] is selected, [Paper Type] is automatically set to [Envelope].



Check that [Paper Size] is set to [Same as Original Size].



Select [Bypass Tray] from [Paper Tray].



Click [OK].

Execute printing.
The following screen is displayed.



Load envelopes or postcards into the Bypass Tray with the print side facing down.

Insert envelopes or postcards into the tray until their edges are pressed against the back.



When loading envelopes or postcards into the Bypass Tray, note the following points.

When loading envelopes, remove air from them, and securely press along the flap fold line. Otherwise, it will result in an envelope wrinkle or paper jam.

Do not use envelopes that have glue or release paper on the flap or the part covered by the flap on the body. Otherwise, the machine may be damaged or a
failure may occur.

When loading curled postcards, uncurl the postcards as shown in the figure in advance.



Slide the Lateral Guide to fit the size of the loaded paper.

When using the Bypass Tray, note the following points.



Do not put spare envelopes into the Bypass Tray. Doing so causes a size detection error.

Do not put spare postcards in the Bypass Tray. Doing so causes a size detection error.

Tapping [Complete] starts printing.

If you cannot tap [Complete], check whether the paper setting of the printer driver matches that of the main unit. In addition, remove envelopes or postcards
loaded in the Bypass Tray, then reload them.





Changing the Encryption Passphrase

Encryption passphrase

An encryption passphrase is information used for encrypting the password that is sent to this machine for printing using the printer driver.

When printing is executed, some functions may send an authentication password such as the user password or account password. The password is encrypted using the
encryption passphrase specified in advance in this machine. However, you can change the encryption passphrase when necessary.

To change the encryption password, you need to set the same encryption passphrase in this machine and in the printer driver.

If the encryption passphrase set in this machine differs from the one set in the printer driver, printing cannot be executed because this machine cannot
decrypt the encrypted password.

Setting the encryption passphrase for this machine (for the administrator)

Tap [Utility] - [Administrator] - [Security] - [Driver Password Encryption Setting].

Select [User-Defined] and also tap [Encryption Passphrase].

Tap [Encryption Passphrase] and enter the new encryption passphrase (using 20 alphanumeric characters,
including symbols).

Tap [Encryption Passphrase Confirmation], and enter the encryption passphrase again.

An encryption passphrase using a series of the same letters (for example, "1111") is invalid.

Tap [OK].



This sets the encryption passphrase.

Setting an encryption passphrase for the printer driver

Do not perform the following steps when you do not want to change the encryption passphrase on this machine.

If OpenAPI communication is SSL-encrypted and the device information can be automatically obtained from the printer driver, the encrypted passphrase can be
obtained from this machine. For details on how to encrypt OpenAPI communication with SSL, refer to Here.

Display the [Properties] window of the printer driver.

For information on how to display the [Properties] window, refer to Here.

In the [Configure] tab, select the [Encryption Passphrase] check box and enter the encryption passphrase
(using 20 alphanumeric characters, including symbols) that you have set on this machine.

Do not select the [Encryption Passphrase] check box unless you want to change the encryption passphrase on this machine.
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Click [OK].



Printing Using the PPD Driver for Applications

About PPD driver for applications

Install the PPD driver for applications when using PageMaker or other applications that requires a PPD.

PPD registration destination (Example: Adobe PageMaker)

For PageMaker 6.0: 
Copy the PPD file to RSRC\PPD4 under the folder to which PageMaker is installed.

For PageMaker 6.5 and 7.0: 
Copy the PPD file to RSRC\<Language>\PPD4 under the folder to which PageMaker is installed.

Printing procedure

The following describes the printing procedure in which the PPD driver for applications is used.

Open the data in the application. From the menu bar, click [File] - [Print].

From the [PPD] box in the print window, select this machine.

In [Paper] or [Features], configure the print settings.

Click the [Print] button to execute printing.



[Properties] Window of the Printer Driver

How to display the [Properties] window

The printer driver has two windows for configuring settings: the [Properties] window and the [Printing Preferences] window. The following explains the [Properties] screen.

In the [Properties] screen, you can set the optional environment of this machine and Windows OS functions. You can open the [Properties] screen as follows.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Open the printer properties.

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, right-click the icon of the installed printer, and from [Printer
Properties], click the displayed printer name.
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In Windows Server 2008, right-click the icon of the installed printer, then click [Properties].



The [Properties] screen appears.

Tabs provided by Windows

The [General], [Sharing], [Port], [Advanced], [Color Management], and [Security] tabs are provided by Windows.

You can print a test page, configure printer sharing, configure printer ports, etc. For details, refer to the Windows manuals.



Available Operations in the [Configure] Tab

In the [Configure] tab, specify which options are installed in this machine, which paper type is assigned to a paper tray, and other information using the printer driver. You
can automatically obtain information of this machine to configure settings and manually register them.

Setting Description

[Device Option]
The model name, options installed on this machine, and authentication settings of this machine are displayed.
When the settings of this machine cannot be obtained, you need to manually change the settings. Select an item to change
from the list, and set a value in the [Setting].

[Paper Tray Information]
The paper types assigned to the paper trays of this machine are displayed.
When the settings of this machine cannot be obtained, you need to manually change the settings. In [Paper Tray Settings...],
change the paper type assignment.



[Set Paper Name by User...] Register the user paper name used in the printer driver. Set a paper name and a paper type as the custom paper name.

[Obtain Device Information]
The PC communicates with this machine and obtains the optional device installation information.
In [Obtain Settings...], set the method of obtaining the information on this machine.

[Obtain Settings...] Configure the settings to obtain the information of this machine.

[Auto] Select this check box to automatically obtain the information of this machine.

[Destination Settings]

Set the communication method to use to obtain information from this machine.
[Device which Connect with Printer Port]: Information is obtained from the printing port specified in the [Port] tab in the

driver.

[Specify IP Address or Printer Name]: Information is obtained by connecting to a device with the entered IP address or

printer name.

[SNMP Settings]

Configure SNMP v1/v2c and SNMP v3 communication settings.
[UDP Port Number]: Change the UDP port number as needed.

[SNMP Version]: Select the required SNMP version.

[SNMP v1/v2c Setting]: Configure SNMP v1 or v2c settings. 
[Read Community Name]: Enter a read-only community name.

[SNMP v3 Setting]: Configure SNMP v3 settings. 
[Discovery User Name]: Enter the user name for detection. 
[Read User Name]: Enter the read-only user name. 

[Context Name]: Enter the SNMP context name. 
[Security Level]: Select a security level for the read-only user. 
[Authentication Algorithm]: Select an authentication algorithm. 
[Read auth]: Enter the authentication password of the read-only user. 
[Encryption Algorithm]: Select an encryption algorithm. 
[Read priv]: Enter the password for privacy (encryption) of the read-only user.

[Enter Password to acquire Device
Information]

Enter the password for user authentication if the device information is password-protected against access through the driver
by setting [Assign Account to Acquire Device Info] (Here) on this machine.

[Use proxy server] Specify whether to conduct printing and communications using the proxy server set to the computer.

[Encryption Passphrase] Select this check box when you want to set your own encryption passphrase.
The encryption passphrase is used for encrypting the authentication password that is sent to this machine for executing
printing. In normal circumstances, the authentication password is encrypted using the encryption passphrase registered in
advance in this machine. However, you can change the encryption passphrase if necessary.
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When [Auto] in [Obtain Settings...] is enabled and the computer is unable to communicate with this machine, the computer takes a long time to display the
[Properties] window or the [Printing Preferences] window.

To change the encryption passphrase, change the settings of this machine, then enter the preset encryption passphrase for
the driver. For details on how to change the encryption passphrase, refer to Here.

[Software Tools] You can start up the software tools such as Web Connection.
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Available Operations in the [Settings] Tab

In the [Settings] tab, you can change the default settings for how confirmation messages are displayed as well as the screen for inputting authentication information.

Setting Description

[EMF Spool] Select this check box when meta file (EMF) spooling is required in your own system environment.

[Display Constraint Message]
Select this check box to display a message indicating that you have selected printer driver functions that cannot be used
together.

[Display paper set in Print Server
Properties]

Select this check box when using the paper added in [Server Properties] in the printer window.

[Optimize CAD data Printing] Select this check box to print CAD data. In some cases, the print data size is reduced, increasing the printing speed.



Do not select this check box when not printing CAD data.

[[Output Method] when printing is
preserved]

The [Output Method] settings in the [Basic] tab are saved. This option is helpful when you want to repeat printing with the
same output method settings.

[Paper Settings for Each Tray] Clear this check box to select the paper type in [Paper Type] when [Paper Tray] is not set to [Auto] in the [Basic] tab.

[Share Overlay File(s)] To share overlay files, set a shared folder on the network for storing them.

[Authentication Settings...]

Configure the User Authentication/Account Track settings.

[Verify Authentication settings before printing]: Select this check box to enable the [Verify] button in the
[Authentication/Account Track] dialog box.

[Popup Authentication Dialog when printing]: Select this check box to display the [Authentication/Account Track] dialog
box when starting printing. This option reminds you to enter the user name and password.

[Do not allow changes to the [User Name]]: This option restricts changes to [User Name] of [Recipient User] in the
[Authentication/Account Track] dialog box in the [Basic] tab.

[Do not allow changes to the [Password]]: This option restricts changes to [Password] of [Recipient User] in the
[Authentication/Account Track] dialog box in the [Basic] tab.

[Secure Print Settings...]

Configure the Secure Print settings.

[Secure Print only]: [Output Method] in the [Basic] tab is fixed to [Secure Print].

[Enter ID/PWD to execute secure print]: Select this check box to display the [Secure Print] dialog box when starting
secure printing. This option reminds you to enter the document ID and password.

[Print without Password]: Specify whether to allow users to print without entering the password.

[My Tab Settings...]

Configure the display settings for [My Tab] when using [My Tab] of the printer driver. For details on My Tab, refer to Here.

[Display My Tab]: Select this check box to use [My Tab].

[Share My Tab]: Select this check box to share the settings in [My Tab]. When the printer driver is installed in a client by
specifying the shared printer on the server, the [My Tab] settings configured on the server are applied to the client.

[Prohibit Editing]: Select this check box to prohibit the clients from editing [My Tab].

[Display Note]: Select this check box to display notes in [My Tab] when [My Tab] is opened.

[Wake-On-Lan Settings...] Configure a setting for the Wake-On-Lan function.

The [Awake from ErP] (Here) setting must be configured on the machine in to use the Wake-On-Lan function.

[Awake before print from Power Saving Mode]: Select this check box to return this machine from the ErP Auto Power
OFF mode to the normal mode before sending a print job.
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[MAC Address 1]: When only the wired or wireless connection is used for this machine, the MAC address of the wired or
wireless LAN device of this machine is specified automatically. When both the wired and wireless connections are used
for this machine, the MAC address of the wired LAN device of this machine is specified automatically.

[MAC Address 2]: When both the wired and wireless connections are used for this machine, the MAC address of the
wireless LAN device of this machine is specified automatically.

[Save Custom Size...]
If you print on odd size paper, specify the size to register the paper.

The registered paper size can be selected from [Original Size] in the [Basic] tab.



[EMF Spool] is a function of the PCL driver.

[Save Custom Size...] is a function of the PCL driver.

To use the EMF spool function with a PS driver, select the [Enable advanced printing features] check box in the [Advanced] tab to enable the EMF spool
function.

The procedure for opening [Server Properties] is as follows: 
In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, select a printer, and click [Print Server Properties] on the
toolbar. 
In Windows Server 2008, right-click on the area that has nothing displayed in the [Printers] window, then click [Run as administrator] - [Server Properties].

The paper set in Print Server Properties for the printer driver is allowable in the following ranges. 
Custom sizes available in printer driver: 
Width: 3-9/16 to 12-5/8 inches (90.0 to 320.0 mm), Length: 5-1/2 to 18 inches (139.7 to 457.2 mm) 
Banner sizes available in printer driver: 
Width: 3-9/16 to 11-11/16 inches (90.0 to 297.0 mm), Length: 18 to 47-1/4 inches (457.3 to 1200.0 mm) 
Allowable range of large size 1: 
Width: 3-9/16 to 8-1/4 inches (90.0 to 209.0 mm), Length: 18 to 46-13/16 inches (457.3 to 1189.0 mm) 
Allowable range of large size 2: 
Width: 11-11/16 to 12-5/8 inches (297.1 to 320.0 mm), Length: 18 to 46-13/16 inches (457.3 to 1189.0 mm) 
Allowable range of large size 3: 
Width: 12-5/8 to 33-1/8 inches (320.1 to 841.0 mm), Length: 5-1/2 to 46-13/16 inches (139.7 to 1189.0 mm) 
The paper sizes registered in the range of the above custom sizes or banner sizes are available in both [Original Size] and [Paper Size] of the printer driver.
However, the paper size registered in the allowable range of each large size is available only in [Original Size] of the printer driver.

If you set the function layout on the [My Tab] using the Driver Packaging Utility, each user can use those functions in the same layout. 
When creating a driver package with Driver Packaging Utility, move the printer driver that is used as a source of the package to the desired position in My
Tab. In [My Tab Settings...], select the [Display My Tab] and [Share My Tab] check boxes, then configure Driver Packaging Utility to copy the printer
settings. For details on the Driver Packaging Utility settings, refer to the Driver Packaging Utility Help.



[Printing Preferences] Window of the Printer Driver

How to display the [Printing Preferences] page

The printer driver has two windows for configuring settings: the [Properties] window and the [Printing Preferences] window. This section describes the [Printing
Preferences] window.

The [Printing Preferences] window has multiple tabs on each of which related functions are grouped to enable you to configure print functions unique to this machine. To
display the [Printing Preferences] window, take the following steps:

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Open [Printing Preferences].

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, right-click the icon of the installed printer, and from [Printing

Preferences], click the displayed printer name.
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In Windows Server 2008, right-click the icon of the installed printer, then click [Printing Preferences...].



The [Printing Preferences] window of the printer appears.

The print settings changed here are registered as default values. When you want to temporarily change settings to print from application software, click
[Properties] (or [Preferences]) in the [Print] window to open the [Printing Preferences] window.

Items common to each tab

The following explains the commonly used settings and buttons in each tab.



Setting Description

[Favorite Setting]
You can register the current print settings as a favorite and recall it when executing printing.
For details on the [Favorite Setting], refer to Here.

View
Selecting [Paper View] displays a sample page layout based on the current settings for checking the output result image.
Selecting [Printer View] displays a printer figure showing the options, such as paper trays, installed in the machine.

[Printer Information]
Click this button to start Web Connection and check the printer information. This button is enabled only when your computer
can communicate with this machine.

[OK] Applies the changes made to the settings and closes the setting window.

[Cancel] Discards (or cancels) the current changes and closes the setup window.

[Help] Displays the help for each item in the window.

[Default] Reverts the settings to their default values.
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Available Operations in [My Tab]

[My Tab] enables you to customize the display contents.

You can gather setting items from difference tabs and place them in [My Tab]. Registering frequently used setting items in [My Tab] enables you to change settings in one
tab, without switching among multiple tabs.

For details on how to edit [My Tab], refer to Here.

The comment field containing [More Details] or [Do not show again] is not displayed if [Display Note] is disabled in [My Tab Settings] in the [Settings] tab of
the [Properties] window.

[Edit My Tab...] is not displayed when the [Settings] tab - [My Tab Settings] - [Prohibit Editing] is enabled in the [Properties] window.

Available Operations in the [Settings] Tab (Here)

Setting Description

[More Details] Click this button to display the Help of [My Tab].

[Do not show again] Select this check box if you do not want to display the comment field containing [More Details].

[Edit My Tab...] Click this button to register or delete the functions displayed in [My Tab].
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Available Operations in the [Basic] Tab

In the [Basic] tab, you can configure basic settings about paper or printing. Functions that are frequently used during normal printing are placed in this tab.

Setting Description

[Original Orientation]
Specify the orientation of the original created in application software.

If the setting in the printer driver differs from the one specified in the application software, correct the setting.

[Original Size]

Select the size of the original created in application software.

If the setting in the printer driver differs from the one specified in the application software, correct the setting.

To print on custom sized paper, select [Custom Size] and specify the length and width. For details, refer to Here.

[Paper Size]

Select the size of paper for printing.

If this setting differs from the original size and [Zoom] is set to [Auto], the original is enlarged or reduced to the selected paper
size.

To print on custom sized paper, select [Custom Size] and specify the length and width. For details, refer to Here.

[Zoom]

Select how the print image is enlarged or reduced.

[Auto]: The image is enlarged or reduced to the size specified in [Paper Size].

[Manual-lock aspect ratio]: The image is enlarged or reduced with the specified ratio (25 to 400%).

[Manual-var. aspect ratio]: The image is enlarged or reduced with the ratio values specified in the horizontal and vertical
directions (25 to 400%).

[Paper Tray]
Select the paper tray for the printing paper.

When you select [Auto], the tray containing the paper selected in [Paper Size] is automatically used.

[Paper Type] Select the type of paper for printing.

[Output Method] Select the method to use to print the original from this machine.

[Print] Select this option to print normally.

[Secure Print]
Select this option to print highly confidential documents. Printing is permitted when the document ID and password are
entered on this machine.
For details, refer to Here.

[Save in User Box]
Select this option to save the original in a User Box on this machine.

For details, refer to Here.

[Save in User Box/Print] Select this option to save the original in a User Box on this machine and print it at the same time.
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For details, refer to Here.

[Proof Print]
Select this option to print a large number of copies. This machine prints only one copy and waits for the user's command
before printing the remaining copies.
For details, refer to Here.

[ID&Print]
Select this option to print highly confidential documents in an environment where user authentication is employed. Printing is
permitted when the user is authenticated to use this machine.
For details, refer to Here.

[User Settings...]
When you have selected [Secure Print] or [Save in User Box] ([Save in User Box/Print]) in [Output Method], enter the
required information.

[Authentication/Account Track...]
When user authentication or account track is employed, enter the user name or account name and the password. For details,
refer to Here.

[Copies] When printing multiple sets of copies, specify the number of sets.

[Collate]
When printing multiple sets of copies, select this check box to output sets of copies one by one.

When this check box is cleared, the first page of the original is printed on as many sheets as the number specified in
[Copies], and then each of the subsequent pages is printed in this manner.

[Offset] When printing multiple sets of copies, select this check box to output each set as a staggered layer.

[Paper Settings for Each Tray...]

Specify the type of printing paper for each tray. When you specify anything other than [Auto] in [Paper Tray], the paper type
information specified here is applied.
Ensure that the settings correspond correctly to the paper that has been loaded into the paper trays of this machine. Use this
setting when you cannot change the settings in the [Configure] tab of the [Properties] window because you do not have the
administrator privileges.

Select the tray in [Printer Driver Settings]. Then, in [Paper Type], specify the type of the paper to be loaded in the selected
tray. Clicking [Reflect Device Status] reflects the settings.

This option is available when [Paper Settings for Each Tray] is enabled in the [Settings] tab.
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[12 e 18] in [Paper Size] is equivalent to 304.8 e 457.2 mm that is slightly larger than A3.

In [Original Size], you can select A0, A1, A2, B1, B2, or B3. However, the original is reduced to the size specified in [Paper Size]. In this case, you cannot
select [Same as Original Size] in [Paper Size]. 
Likewise, the large size registered in Print Server Properties is also reduced to the size specified in [Paper Size]. The paper set in Print Server Properties is
available when the [Display paper set in Print Server Properties] check box is selected in the [Settings] tab.

When you want to print on the entire paper of the standard size, select "W" for each standard size in [Original Size]. The original is printed at the center of
paper larger than the original. 
For example, if you want to center and print 8-1/2 e 11 (A4) size data on 11 e 17 (A3) sized paper, create data with the "8-1/2 e 11W" ("A4W") size, and then,
using the printer driver, set [Original Size] to [8-1/2 e 11W] ([A4W]) and specify the paper tray to be used as [Paper Tray]. 
On this machine, load 11 e 17 (A3-size) paper into the required tray, and check the paper size as follows. 
Select the tray in [Paper] for the copy mode. Then, check that [Auto Detect] is selected in [Paper Size] and 11 e 17 (A3) is displayed when [8-1/2 e 11W]
([A4W]) is specified in [Wide Paper] on the tray setting change screen. 
If 12 e 18 paper is loaded, select [12 e 18] in [Paper Size]. 
To print data on custom-size paper, use one of Tray 1, Tray 2, and Bypass Tray. Then, select [8-1/2 e 11W] ([A4W]) in [Wide Paper] on the tray setting
change screen, and enter the desired paper size in [Change Size].

In [Paper Type], specify [Side2] when printing on the back side of paper.

In [Paper Type], [User] specifies the paper type registered in this machine.

If you have registered the custom papers in [Set Paper Name by User...] of [Configure] tab, you can select the registered custom papers from the [Paper
Type] list.



Available Operations in the [Layout] Tab

In the [Layout] tab, you can configure layout settings for printing. You can combine pages or adjust print positions.

Setting Description

[Combination]

Select how the original pages are combined on sheets.

[2 in 1]/[4 in 1]/[6 in 1]/[9 in 1]/[16 in 1]: 
Multiple pages are reduced and printed on the same side of one sheet. For example, when you select [9 in 1], every set

of nine pages is reduced and printed on the same side of one sheet.

[2 e 2]/[3 e 3]/[4 e 4] (PCL only): 

The original image is enlarged, divided, and printed on multiple sheets. For example, when you select [2 e 2], one page
of the original is divided and printed onto four sheets. When you join the printed sheets together, a large poster is
created.

As necessary, click [Combination Details...] to configure detailed settings about page combination.

[Combination]: Select the page combination.

[Layout Order]: When you have selected "N in 1" in [Combination], select the order of pages in the layout.

[Border]: When you have selected "N in 1" in [Combination], select this check box if you want to draw border lines
between pages. In addition, select the type of border lines.

[Overlap width line]: When you have specified "N e N" in [Combination], select this check box if you want to create
overlap margins.

[Rotate 180]

Select this check box to rotate the original 180 degrees and print it.

Click [180-Degree Rotation Setting...], and specify the target to be rotated 180 degrees in detail.

[Target Original]: Specify the original of the target to be rotated 180 degrees.

[Original Size]: Specify the original size of the target to be rotated 180 degrees when [Specify the Original Size and
Original Orientation] is selected in [Target Original].

[Original Orientation]: Specify the orientation of the target to be rotated 180 degrees when [Specify the Original Size and
Original Orientation] is selected in [Target Original].

[Skip Blank Pages] Select this check box to exclude blank pages in the original from the pages to be printed.

[Chapters] When you have selected [2-Sided] or [Booklet] in [Print Type], select this check box if you want to print particular pages on
the front side.
In [Entry Example], specify the page numbers of the pages you want to print on the front side. To specify multiple page
numbers, separate each number with a comma (for example, "2,4,6") or connect the numbers using a hyphen (for example,



"6-10").

[Print Type]

Select the print sides of paper.

[1-Sided]: The original is printed on one side of paper.

[2-Sided]: The original is printed on both sides of paper.

[Booklet]: The original is printed in booklet format. The pages in the original data are arranged, spread, and printed on
both sides of sheets. When the printed sheets are stacked and folded in two, the pages are arranged in the correct
order.

[Binding Position] To perform 2-sided printing or to create a margin, select the binding position.

[Binding Margin]

Select this check box to provide a margin on printed sheets.

Click [Binding Margin Settings...] to specify the size of the margin in detail.

[Shift Mode]: Select how the images are shifted for creating the margin.

[Front Side]: Specify the size of the margin on the front side.

[Back Side]: When you print on both sides, specify the size of the margin on the back side. When the [Same value for
front and back sides] check box is selected, a margin of the same size is created on both front and back sides.

[Image Shift]

Select this check box to fine tune (shift) the print position of the image with respect to the paper.

Click [Image Shift Settings...] to specify the print position in detail.

[Front Side]: Specify the upward/downward and rightward/leftward shift distances for the front side.

[Back Side]: When you print on both sides, specify the upward/downward and rightward/leftward shift distances for the
back side. Selecting the [Same value for Front and Back sides] check box applies the same settings to both sides.



Available Operations in the [Finish] Tab

In the [Finish] tab, you can configure settings for the finish of printouts.

To use Staple, Center Staple and Fold, Punch, or Fold, the appropriate option is required. For details on the required option, refer to Here.

The number of punched holes varies depending on the area you are in.

When using the Z-fold function, specify the paper size indicated in the setting value ([Z-Fold (A3, B4, 11 e 17, 8K)] or [Z-Fold (8 1/2 e 14)]), which you select
from the drop-down list, in "Paper Size" of the application software or printer driver.

Setting Description

[Staple] Select this check box to staple the printed sheets. In addition, specify the number and positions of staples.

[Center Staple and Fold]
Select this check box to staple the printed sheets in two positions in the center.

Use this option when you have set [Print Type] to [Booklet] in the [Layout] tab.

[Punch]
Select this check box to make punch holes (binder holes) in the printed sheets. In addition, specify the number and positions
of punch holes.

[Fold] Select this check box to fold the printed sheets. In addition, select the folding mode.

[Page Fold Setting]
When you have selected [Half-Fold(By Sheet)] or [Tri-Fold(By Sheet)] in [Fold], specify the number of pages to be folded at
one time.

[Output Tray] Select the tray to which the printed sheets are output.

[Paper Arrangement]

Select whether to adjust the binding position on two-sided printed sheets collectively after all data items are received or
sequentially each time a data item is received.

[Prioritize Arranging Papers]: Paper arrangement is performed once after all data items are received. All pages are

adjusted under the same conditions.

[Prioritize Productivity]: Paper arrangement is performed sequentially while printing the pages.
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Available Operations in the [Cover Mode] Tab

In the [Cover Mode] tab, you can insert covers and pages. You can also change the layout or finish between pages.

Setting Description

[Front Cover]

Select this check box to insert and print on a front cover. In [Front Cover Tray], select the paper tray for the front cover. Then,
select whether to print on the inserted front cover.

[Blank]: Nothing is printed on the inserted front cover.

[Print]: The first page of the original is printed on the inserted front cover.

You can set this option when you have selected anything other than [Auto] in [Paper Tray] in the [Basic] tab.

[Back Cover]

Select this check box to insert and print on a back cover. In [Back Cover Tray], select the paper tray for the back cover. Then,
select whether to print on the inserted back cover.

[Blank]: Nothing is printed on the inserted back cover.

[Print]: The last page of the original is printed on the inserted back cover.

You can set this option when you have selected anything other than [Auto] in [Paper Tray] in the [Basic] tab.

[Front Cover from Post Inserter]
Select this check box when inserting an outside front cover for printing while the optional Post Inserter is installed on the
machine. In addition, select the PI tray for the front outside cover.
You can set this option when you have selected anything other than [Auto] in [Paper Tray] in the [Basic] tab.

[Back Cover from Post Inserter]
Select this check box when inserting an outside back cover for printing while the optional Post Inserter is installed on the
machine. In addition, select the PI tray for the back outside cover.
You can set this option when you have selected anything other than [Auto] in [Paper Tray] in the [Basic] tab.

[Per Page Setting]
Select this check box to insert sheets into the original or change the print settings page by page. In addition, select the list to
apply to printing.
Click [Edit List...] to create in advance a list containing detailed print settings. For details, refer to Here.

[Transparency Interleave]
When printing on multiple transparencies, select this check box if you want to insert paper between the transparencies. In
[Interleave Tray], select the paper tray for the paper to be inserted.
You can set this option when you have selected [Transparency] in [Paper Type] in the [Basic] tab.

[Carbon Copy]
Select this check box to print the original on different sheets of paper loaded into multiple trays.

Selecting the [Carbon Copy] check box displays the [Carbon Copy Settings] window. Specify the output order or trays used
for carbon copying. For details, refer to Here.
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[Front Cover] and [Front Cover from Post Inserter] or [Back Cover] and [Back Cover from Post Inserter] cannot be specified simultaneously.



Available Operations in the [Stamp/Composition] Tab

In the [Stamp/Composition] tab, you can configure settings for adding text or an image to the original. You can add the date/time or page numbers to the original or
compose a watermark or an overlay image.

Setting Description

[Watermark]
Select this check box to print a watermark (text stamp) on the original. In addition, from the list, select the watermark you
want to print.

Clicking [Edit...] enables you to register or edit a watermark. For details, refer to Here.

[Overlay] An overlay image to be composed on the original is created. The created overlay image is composed onto the original.

[Create Host Image]
Data created in application software is saved in the computer as an overlay image to be composed on the original. For
details, refer to Here.

[Create Shared Folder Image]
Data created in application software is saved in the shared folder on the network as an overlay image to be composed on the
original. For details, refer to Here.

[Print Host Image]

The overlay image created with [Create Host Image] or [Create Shared Folder Image] is printed on the original as a
composite image.

Clicking [Edit...] allows you to add or delete an overlay image or change the method of composing overlay images. For
details, refer to Here.

[Print Device Image] (PCL only)
An overlay image registered in this machine is recalled and printed on the original as a composite image.
Clicking [Edit...] allows you to add or delete an overlay image or change the method of composing overlay images. For
details, refer to Here.

[Copy Security]
A pattern that deters unauthorized copying is composed on the original.
Clicking [Edit...] enables you to configure detailed settings such as the item to be printed or how it is printed. For details, refer
to Here.

[Copy Protect] Text such as "Copy" and "Private" are printed in the background pattern as concealed text on each printed sheet.

[Stamp Repeat] On every page of the printed document, a text such as "Copy" or "Private" is printed as an invisible text.

[Copy Guard]
Copy Guard is a copy protection function that prints concealed security watermarks such as "Private" or a date in the
background to prevent unauthorized copying, and embeds a copy restriction pattern on all printed sheets.

[Password Copy]
Password Copy is a copy protection function that prints concealed security watermarks such as "Private" or a date in the
background to prevent unauthorized copying, and embeds a password for the password copy function on all printed sheets.
Enter the password to be embedded (using up to eight characters).
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To use Copy Guard or Password Copy, the appropriate option is required. For details on the required option, refer to Here.

The setting on the machine side is required in advance to use Copy Guard or Password Copy. For details on the required settings, refer to Here.

[Date/Time] Select this check box to add the print date/time to the original.

Clicking [Edit...] enables you to change the print position and format of the text. For details, refer to Here.

[Page Number]
Select this check box to add page numbers to the original.
Clicking [Edit...] enables you to change the print position and the page from which the printing starts. For details, refer to
Here.

[Header/Footer]

Select this check box to add the date and time and arbitrary text to the top or bottom margin (header/footer) of the original.
Select the information to be added to the header/footer from those registered in this machine.

Clicking [Edit...] enables you to change the range of pages on which the header/footer is printed and other settings. For
details, refer to Here.

https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id13-_104514329.html#id13-_104514333
https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/opkey_463_S.html#UT_104517431
https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id01-_104515045.html#id01-_104515051
https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id01-_104515045.html#id01-_104515051
https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id01-_104515045.html#id01-_104515052


Available Operations in the [Quality] Tab

In the [Quality] tab, you can configure settings for the image quality of the original. You can specify colors, image processing, and font processing.

Items that can be specified vary depending on your printer driver.

Setting Description

[Select Color]

Select colors for printing.

[Auto Color]: The color mode is automatically selected according to the original color.

[Full Color] (PS only): The original is printed in full color regardless of whether the original is in color or in black and
white.

[Gray Scale]: The original is printed in black and white regardless of whether the original is in color or in black and white.
To prevent colored text, lines, or figures from being printed faint, select the [Print with Black] check box (PCL only).

[2 Color (Text Priority)] (PCL only): The gray areas and color areas of an original are printed using combinations of the
respectively specified colors. This option provides color reproducibility focused on the visual quality of text.

[2 Color (Photo Priority)] (PCL only): The gray areas and color areas of an original are printed using combinations of the

respectively specified colors. This option provides color reproducibility focused on the visual quality of photos.

[Quality Adjustment]

The image quality is fine tuned according to the original.

[Simple]: The image quality of the entire original is adjusted. Specify the type of the color profile used for printing.

[Detail]: The image quality of the original is adjusted in detail for each element such as text, photos, figures, tables, and
graphs. For each element, specify the type of the color profile used for printing and other profiles to be applied.

When you are using the PS driver, you can manage the ICC profiles with [Quality Adjustment]. For details, refer to Here.

[Image Quality Setting]

Select the optimum quality setting mode to suit the original.

[Document/Photo]: Applies the image quality setting suitable for originals containing multiple elements, such as text,
graphs, figures, and photos.

[Document]: Applies the image quality setting suitable for originals containing texts primarily.

[Photo]: Applies the image quality setting focused on the image quality.

[CAD]: Applies the image quality setting suitable for originals composed of thin lines. Images are reproduced in high

resolutions.

[Line Width Adjustment]
Adjusts the width of a text or line. Ordinarily, adjustment is made in the method specified on the main unit side. To change
the setting depending on the contents of the original, select the adjustment method.

[Resolution] Select the print resolution.
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[600dpi]: Printed with 600 dpi.

[1200dpi (Rasterize on Device)]: Printed with 1200 dpi after drawing processing is carried out by the machine.

* Printing speed may decrease when printing in 1200 dpi e 1200 dpi mode, or when printing on paper other than plain paper.

[Pattern] (PCL only) Select the pattern density.

[Image Compression] (PCL only)

Select the compression mode for the image data contained in the original.

[Best Quality]: The process prioritizes quality. Quality is improved, but printing takes a long time.

[High Compression]: The process prioritizes speed. The printing time is shortened, but the printing quality is
deteriorated.

[High/Smaller Image Size]: The image data is compressed and reduced, and the process prioritizes speed. For some
image data, its print time can be reduced than the [High Compression] mode.

[Auto Trapping]
Select this check box to prevent misalignment or generation of white space. Select this option to superimpose neighboring
colors to print so as to prevent generation of white space around a picture.

[Black Over Print] (PS only)

Select this check box to prevent generation of white space around black characters or figures. Select this check box to
superimpose black color on a neighboring color to print so as to prevent generation of white space around black characters
or figures.

[Text]: Only black characters are overprinted.

[Text/Figure]: Figures and black characters are overprinted.

[Glossy Mode] Select this check box to print images with a glossy finish. The printing speed is reduced.

[Toner Save] Select this check box to save the amount of toner consumed. The printing density is reduced.

[Edge Enhancement] Select the level to highlight edges of an image.

[Font Settings]

Specify how to process texts.

Select a type of fonts to be downloaded from the PC to this machine. Also specify whether to replace the TrueType fonts by
printer fonts when printing.

If characters are garbled in an environment using the PCL driver, we recommend that you select [Bitmap] in [Download Font
Format] and clear the [Use Printer Fonts] check box.



Available Operations in the [Other] Tab

In the [Other] tab, you can check the driver version and configure print settings for application software.

[Excel Job Control] and [Remove White Background] are not available when 32-bit application software is used in the 64-bit operating system.

You can change the [Excel Job Control] setting when the printer driver setting dialog box is displayed on the [Devices and Printers] ([Printers] in Windows
Server 2008) window.

Setting Description

[Excel Job Control]
Select this check box to print multiple Microsoft Excel sheets with different page settings at one time.

When multiple sheets with different page settings are printed at one time, the sheets may be separated into single-sheet jobs
depending on the data contained. This function avoids job separation as much as possible.

[Remove White Background] (PCL
only)

Select this check box to superimpose an overlay image on Microsoft PowerPoint data.

White areas are removed so that the white background of the PowerPoint data does not hide the overlay image. Clear this
check box to print the original as is without removing the background.

[Thin Line Support] (PCL only)
Select this check box to perform reduced-size printing. This function prevents thin lines from disappearing.

This is effective for thin lines such as table borders created in Excel, but not for thin lines used in illustrations.

[MFP Authentication]

Select this check box to log in using the MFP authentication function when both MFP authentication and server
authentication are used for user authentication.
This option is available when [Device Option] - [User Authentication] in the [Configure] tab is set to [ON (MFP) + ON
(External Server)] or [ON (MFP) + ON (Enhanced Server)].

[Convert to Gray Scale] (PCL only)
The RGB values of the original are checked, and if the difference between respective values is equal to or less than the
specified threshold, the colors of the original are converted into gray scale. This option is valid when [Auto Color] is selected
in [Select Color] in the [Quality] tab.

[About] The version of the printer driver is displayed.



Uninstalling the Printer Driver

Using the deletion program for deletion

If the printer driver was installed using the installer, the deletion function for the printer driver is also installed.

Administrator privileges are required to perform this task.

Open [Programs and Features].

For information on how to open [Programs and Features], refer to Here.

In the list, double-click [KONICA MINOLTA XXXSeries] ("XXX": model name).

Select the printer driver you want to delete, then click [Uninstall].

From then on, follow the instructions on the pages that follow.
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If the dialog box prompting to restart the computer, click [OK].
This completes the deletion process of the printer driver.

Deletion using the installer

If you installed the printer driver using the installer, you can delete it using the installer.

Administrator privileges are required to perform this task.



Insert the driver DVD into the DVD drive of the computer.

Make sure that the installer starts, and then proceed to step 2.

If the installer does not start, open the driver folder on the DVD, double-click [Setup.exe] (in the 32-bit environment) or [Setup64.exe] (in the 64-bit

environment), and proceed to step 3.

Select the [Agree the Software End User License Agreement.] check box.

Select [Uninstall Printer Driver] in [Select menu to setup], and click [Next].

Select the printer driver you want to delete, then click [Uninstall].

From then on, follow the instructions on the pages that follow.

If a dialog box prompting you to restart the computer appears, click [OK] to restart the computer.
This completes the deletion process of the printer driver.



Checking the Connection Method

The installation method for the printer driver differs depending on the method used to connect this machine to the computer. When this machine is connected to the
network, there are several printing protocols. The installation method for the printer driver also differs depending on the protocol.

Connection method in which setup is possible using Add Printer Wizard

Connection method in which plug and play-based setup is possible

Connection method Description

LPR
A network connection using the LPR (Line Printer Remote) print service. It uses a TCP/IP protocol and the LPR printing port.

For the installation procedure, refer to Here.

Port 9100
A network connection using the Port 9100 print service. Use the TCP/IP protocol, and set RAW as the printing port.

For the installation procedure, refer to Here.

SMB
A network connection using SMB (Server Message Block) for sharing files or printers in Windows. It supports the TCP/IP
protocol.

For the installation procedure, refer to Here.

IPP/IPPS

A network connection using the IPP (Internet Printing Protocol) print service. You can use HTTP (HyperText Transfer
Protocol) of the TCP/IP protocol to print data via the Internet.

IPPS is an IPP for SSL encrypted communication.

For the installation procedure, refer to Here.

WSD

WSD (Web Service for Device) is a function to search for a WSD-compatible device on the network.

This function enables you to automatically detect the machine connected to the network and easily install it as a WSD printer.

For the installation procedure, refer to Here.

USB A connection using a USB port.

Connection method Description

USB
A connection using a USB port.

For the installation procedure, refer to Here.
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In User's Guide manuals, location paths of folders or files may not contain the root directory.

When manually installing the Windows printer driver, specify all the driver files in the folder of the desired language.



Installation Using an LPR/Port 9100 Connection

Preparation required to use this function (for the administrator)

Configure the LPR/Port 9100 operating environment.

When using Port 9100: 
Make sure that the RAW port number has been set. (In normal circumstances, you can use the default settings.) For details on the setting procedure, refer to Here.

When using the LPR: 
Check that LPD is enabled. (In normal circumstances, you can use the default settings.) For details on the setting procedure, refer to Here.

In Windows 8.1/10/Server 2012/Server 2012 R2/Server 2016/Server 2019

You can install the printer driver by automatically detecting the printer on the network or by creating a new port.

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.
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The [Add a printer] wizard appears.

Select your machine from the list, then click [Next].

If no printers are detected, restart this machine.

Use the IP address to confirm the printer that you want to connect to.

It may take some time to finish searching the entire list of printers.



Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].



The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in the [Devices
and Printers] window.

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.

The procedure for installing the printer driver by creating a new port is as follows:

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.
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Select Add a printer.

In the window showing the detected printer, click [The printer that I want isn't listed].

Click [Add a local printer or network printer with manual settings].

Click [Create a new port:], then select [Standard TCP/IP Port].

Click [Next].



Select [TCP/IP Device], then enter the IP address.

Click [Next].

Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].



After finishing the installation, make sure that the icon for the installed printer is displayed in the [Devices
and Printers] window.

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.

In Windows 7/Server 2008/Server 2008 R2

You can install the printer driver by automatically detecting the printer on the network or by creating a new port.

The procedure for installing the printer driver by automatically detecting the printer on the network is as follows:

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.

In Windows 7/Server 2008 R2, click [Add a printer].
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In Windows Server 2008, click [Add a printer].

The [Add a printer] wizard appears.



Click [Add a network, wireless or Bluetooth printer].
Connected printers are detected.

Select your machine from the list, then click [Next].

If no printers are detected, restart this machine.

Use the IP address to confirm the printer that you want to connect to.

It may take some time to finish searching the entire list of printers.



Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.



The procedure for installing the printer driver by creating a new port is as follows:

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.

In Windows 7/Server 2008 R2, click [Add a printer].

https://manuals.konicaminolta.eu/bizhub-C650i-C550i-C450i/EN/bizhub-c650i-c550i-c450i/contents/id01-_104515191.html#id01-_104515191


In Windows Server 2008, click [Add a printer].

The [Add a printer] wizard appears.



Click [Add a local printer].
The [Choose a printer port] dialog box appears.

Click [Create a new port:], then select [Standard TCP/IP Port].

Click [Next].

Select [TCP/IP Device], then enter the IP address.

Click [Next].

If the [More Port Information Required] window appears, proceed to step 9.

If the [Install the printer driver] dialog box appears, proceed to step 12.

Select [Custom], and then click [Settings...].

Change the settings according to the port, and then click [OK].

For an LPR connection, select the [LPR] check box, then enter "Print" in [Queue Name:]. You must be careful to use the correct case (upper or lower) when
entering letters.

For Port 9100 connection, select the [Raw] check box, and then enter a RAW port number (initial setting: [9100]) [Port Number:].

If both LPR and Port 9100 are enabled on this machine, the printer driver is connected to this machine using LPR.

Click [Next].
The [Install the printer driver] dialog box appears.



Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.





Installation Using a SMB Connection

Preparation required to use this function (for the administrator)

Configure the SMB operating environment.

For details on the setting procedure, refer to Here.

In Windows 8.1/10/Server 2012/Server 2012 R2/Server 2016/Server 2019

You can install the printer driver by automatically detecting the printer on the network or by creating a new port.

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.
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The [Add a printer] wizard appears.

Select your machine from the list, then click [Next].

If no printers are detected, restart this machine.

Select a printer from "\\NetBIOS-name\print-service-name". 

You can confirm the NetBIOS name and print service name in [SMB Print Setting] (Here) on this machine.

It may take some time to finish searching the entire list of printers.
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Click [OK].

Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver



Click [OK].
The [Printers] list appears.

Click [OK].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in the [Devices
and Printers] window.

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.

The procedure for installing the printer driver by creating a new port is as follows:

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].



For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.

In the window showing the detected printer, click [The printer that I want isn't listed].

Click [Add a local printer or network printer with manual settings].

Click [Create a new port:], then select [Local Port].
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Click [Next].

Specify the IP address and port.

Enter "\\NetBIOS-name\print-service-name" in the [Port Name] box.

For the NetBIOS name and print service name, enter the name specified in [SMB Print Setting] (Here) on this machine.

Click [OK].

Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 

Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].
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Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in the [Devices
and Printers] window.

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.

In Windows 7/Server 2008/Server 2008 R2

You can install the printer driver by automatically detecting the printer on the network or by creating a new port.

The procedure for installing the printer driver by automatically detecting the printer on the network is as follows:

Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.

In Windows 7/Server 2008 R2, click [Add a printer].
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In Windows Server 2008, click [Add a printer].

The [Add a printer] wizard appears.



Click [Add a network, wireless or Bluetooth printer].
Connected printers are detected.

Select your machine from the list, then click [Next].

If no printers are detected, restart this machine.

Select a printer from "\\NetBIOS-name\print-service-name". 
You can confirm the NetBIOS name and print service name in [SMB Print Setting] (Here) on this machine.

It may take some time to finish searching the entire list of printers.

Click [OK].

Click [Have Disk...].
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Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 

Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [OK].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in the [Printers]
or [Devices and Printers] window.

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.

The procedure for installing the printer driver by creating a new port is as follows:



Administrator privileges are required to perform this task.

Since the printer is searched for during the installation, be sure to connect this machine to the network before turning it on.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.

In Windows 7/Server 2008 R2, click [Add a printer].
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In Windows Server 2008, click [Add a printer].

The [Add a printer] wizard appears.



Click [Add a local printer].
The [Choose a printer port] dialog box appears.

Click [Create a new port:], then select [Local Port].

Click [Next].

Specify the IP address and port.

Enter "\\NetBIOS-name\print-service-name" in the [Port Name] box.

For the NetBIOS name and print service name, enter the name specified in [SMB Print Setting] (Here) on this machine.

Click [Next].

If the [More Port Information Required] window appears, proceed to step 9.

If the [Install the printer driver] dialog box appears, proceed to step 12.

Select the [Custom] check box, then click [Settings...].

Change the settings according to the port, and then click [OK].

Click [Next] or [OK].
The [Install the printer driver] dialog box appears.
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Click [Have Disk...].

Click [Browse...].

Select a desired printer driver folder in the DVD, and then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.



Installation Using an IPP/IPPS Connection

Preparation required to use this function (for the administrator)

Configure the IPP/IPPS operating environment.

For details on the setting procedure, refer to Here.

In Windows 8.1/10/Server 2012/Server 2012 R2/Server 2016/Server 2019

Administrator privileges are required to perform this task.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.
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The [Add a printer] wizard appears.

In the window showing the detected printer, click [The printer that I want isn't listed].

In [Select a shared printer by name], enter the URL for the machine in the following format, then click
[Next].

http://<IP address of this machine>/ipp 
Example: http://192.168.1.20/ipp



When specifying to use IPPS printing, enter "https://[host name].[domain name]/ipp". 
For [host name].[domain name], specify the host name and domain name registered for the DNS server being used.

If the certificate for the machine is not the one issued by the certifying authority, you must register the certificate for the machine on the Windows

8.1/10/Server 2012/Server 2012 R2/Server 2016 system as the certificate by "Trusted Root Certification Authorities" for the computer account.

When registering the certificate in the machine, check that the certificate shows [host name].[domain name] as the common name.

Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].
The [Printers] list appears.

Click [Next].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].



After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.

In Windows 7/Server 2008/Server 2008 R2

Administrator privileges are required to perform this task.

Insert the driver DVD into the DVD drive of the computer.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Select Add a printer.

In Windows 7/Server 2008 R2, click [Add a printer].
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In Windows Server 2008, click [Add a printer].

The [Add a printer] wizard appears.



Click [Add a network, wireless or Bluetooth printer].
Connected printers are detected.

In the window showing the detected printer, click [The printer that I want isn't listed].

In [Select a shared printer by name], enter the URL for the machine in the following format, then click
[Next].

http://<IP address of this machine>/ipp 
Example: http://192.168.1.20/ipp

When specifying to use IPPS printing, enter "https://[host name].[domain name]/ipp". 
For [host name].[domain name], specify the host name and domain name registered for the DNS server being used.

If the certificate for the machine is not the one issued by the certifying authority, you must register the certificate for the machine on the Windows 7/Server
2008/Server 2008 R2 system as the certificate by "Trusted Root Certification Authorities" for the computer account.

When registering the certificate in the machine, check that the certificate shows [host name].[domain name] as the common name.

Click [Have Disk...].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [OK].



The [Printers] list appears.

Click [OK].

Follow the instructions on the pages that follow.

If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Finish].

After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].

Eject the DVD from the disk drive.
This completes the installation process of the printer driver. Once the settings for the printer have been configured, you can use the printer in the same way as a
general local printer.



Using WSD Connection for Installation

About WSD

WSD (Web Service for Device) is a function to search for a WSD-compatible device on the network.

This function enables you to automatically detect the machine connected to the network and easily install it as a WSD printer.

If this machine joins the Active Directory domain, you can use the "WSD Secure Print function" that can securely perform printing by WSD connection in
Windows 8.1/10.

Preparation required to use this function (for the administrator)

Configure the operating environment for WSD printing.

For details on the setting procedure, refer to Here.

Installation methods

You can install the printer driver by automatically detecting the printer on the network or by specifying the IP address.

The procedure for installing the printer driver by automatically detecting the printer on the network is as follows:

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, install the printer driver first, and then associate it with this machine
through plug and play.

In Windows Server 2008, you can install the printer driver by creating a new port, even if the printer driver is not installed in advance.

Administrator privileges are required to perform this task.

To install a different printer driver in the computer where one has already been installed, you must uninstall the whole package of the currently installed printer driver.

Install the printer driver for this machine.

For details, refer to Here. The printer driver can be installed in any port.
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Turn on the power of the machine while it is connected to the network.

In [Network and Sharing Center] on the computer, check that [Network Discovery] is enabled.

Open the [Network] window.

In Windows 8.1/10/Server 2012/Server 2012 R2/Server 2016/Server 2019, open [Control Panel], select the [Network and Internet] category, then click [View
network computers and devices].

In Windows 7/Server 2008 R2, open [Computer] and click [Network]. 
If [Network] is not displayed, click the [Network and Internet] category on [Control Panel], then click [View network computers and devices].

In Windows Server 2008, open the Start menu, and click [Network].

Connected computers and devices are detected.

Select the device name of the machine, then click [Install] on the toolbar.

In Windows 8.1/10/Server 2012/Server 2012 R2/Server 2016/Server 2019, click [Network] - [Add devices and printers] on the toolbar. On the displayed
window, select the device name of this machine, then click [Next].

You can confirm the device name in [DPWS Common Settings] (Here) on this machine.

The printer driver for this machine is detected and the machine is ready to print.

After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].
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If the printer driver is not correctly installed, the driver must be updated using [Update Driver...]. For details, refer to Here.

The procedure for installing the printer driver by specifying the IP address is as follows:

In Windows Server 2008, you can connect this machine and add a Web service device using the printer addition function.

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, the following installation procedure cannot be used. Use the installation
procedure described in the previous section.

Administrator privileges are required to perform this task.

To install a different printer driver in the computer where one has already been installed, you must uninstall the whole package of the currently installed printer driver.

Turn on the power of the machine while it is connected to the network.

In [Network and Sharing Center] on the computer, check that [Network Discovery] is enabled.

Insert the driver DVD into the DVD drive of the computer.

From the Start menu, click [Control Panel].

Click [Printers] under [Hardware and Sound].

When [Control Panel] is displayed in Classic View, double-click [Printers].

The [Printers] window appears.
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Click [Add a printer].

The [Add Printer] appears.

Click [Add a local printer].
The [Choose a printer port] dialog box appears.

Click [Create a new port:], then select [Standard TCP/IP Port].

Click [Next].

Select [Web Services Device], enter the IP address, and click [Next].
A printer of the entered IP address is located, then the [Found New Hardware] dialog box appears.

Click [Locate and install driver software (recommended)].

If a dialog box to confirm whether to search online appears, click [Don't search online].



Click [Browse my computer for driver software (advanced)].

Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [Open].

Select the folder according to the printer driver, operating system, and language to be used. 
Selectable printer drivers: PCL driver and PS driver

Click [Next].

Click [Close].

Follow the instructions on the pages that follow.

After finishing the installation, make sure that the icon for the installed printer is displayed in the [Printers]
window.

Eject the DVD from the disk drive.
This completes the installation process of the printer driver.



Installation Using a USB Connection

In Windows 7/8.1/10/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019

To connect this machine using the USB port in Windows 7/8.1/10/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, first install the
printer driver and then associate it with this machine through plug and play.

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, the installation disk cannot be specified after the connection has been
established. Install the printer driver in advance.

In Windows Server 2008, you can continue the task and specify the printer driver installation disk to install the printer driver if it has not already been installed.

Administrator privileges are required to perform this task.

Install the printer driver for this machine.

For details, refer to Here.

Connect this machine to the computer using a USB cable.

Turn on the main power of this machine.
The printer driver for this machine is detected and the machine is ready to print.

If the printer driver is not detected, restart this machine.

After finishing the installation, make sure that the icon for the installed printer is displayed in [Devices and
Printers].
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If the printer driver is not correctly installed, the driver must be updated using [Update Driver...]. For details, refer to Here.

Updating the printer driver

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, if this machine is connected without the printer driver having first been
installed, the printer driver will not be correctly identified. If the printer driver is not correctly identified, the driver must be updated using [Update Driver...].

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Right-click the device name of the machine that is under [Unspecified] and then click [Properties].

If [Unknown Device] appears instead of the device name of the machine, right-click to remove the device, and install the printer driver.

In the [Hardware] tab, click [Properties].

In the [General] tab, click [Change Settings].

In the [Driver] tab, click [Update Driver...].

In the page in which to select how to search the driver software, click [Browse my computer for driver
software].
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Click [Browse...].

Specify the folder that contains the target printer driver on the DVD, then click [OK].

Select the folder according to the printer driver, operating system, and language to be used. 

Selectable printer drivers: PCL driver and PS driver

Click [Next].

Follow the instructions on the pages that follow.

Click [Close].

After finishing the installation, make sure that the icon for the installed printer is displayed in the [Devices
and Printers] window.

Eject the DVD from the disk drive. 
This completes the update of the printer driver.

In Windows Server 2008, [Update Driver...] is also available. Under [Device Manager], open [Properties] for this machine that is listed in [Other Devices], and
specify [Update Driver...]. 
(To select [Device Manager], right-click [Computer], and then click [Properties]. Select it in the [Tasks] pane that appears.)



Manually Deleting the Printer Driver

If the printer driver was installed without using the installer, manually delete the printer driver.

Open [Devices and Printers].

For information on how to display [Devices and Printers], refer to Here.

Click the icon of the printer driver to be deleted.

Remove the printer driver.

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, click [Remove device] on the toolbar.

In Windows Server 2008, press the [Delete] key on the computer keyboard.

From then on, follow the instructions on the pages that follow.
When the printer driver is deleted, the icon disappears from the window.

Open [Server Properties].

In Windows 7/8.1/10/Server 2008 R2/Server 2012/Server 2012 R2/Server 2016/Server 2019, select another printer, and click [Print Server Properties] on the
toolbar.

In Windows Server 2008, right-click on the area that has nothing displayed in the [Printers] window, then click [Run as administrator] - [Server Properties].

If the [User Account Control] window appears, click [Continue] or [Yes].

Click the [Driver] tab.
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From the [Installed printer drivers:] list, select the printer driver to be removed, then click [Remove...].

Select [Remove driver and driver package.] in the dialog box for confirming deletion target, then click [OK].

In the dialog box that confirms whether you are sure you want to remove the printer, click [Yes].

Furthermore, a deletion confirmation dialog box appears. Click [Uninstall].

Close the open windows, and then restart the computer.

Be sure to restart the computer.

This completes the deletion process of the printer driver.



Open [Control Panel]

In Windows 10/Server 2019

Click the Start button.

Click [Windows System].

Click [All Apps] - [Windows System] depending on the version of the operating system.

Click [Control Panel].

In Windows 8.1/Server 2012/Server 2012 R2/Server 2016

Press the [X] key while holding down the [Windows] ( ) key.

Click [Control Panel].

In Windows 7/Server 2008/Server 2008 R2

Click the Start menu.

Click [Control Panel].



Open [Devices and Printers]

In Windows 10/Server 2019

Click the Start button.

Click [Windows System].

Click [All Apps] - [Windows System] depending on the Windows 10 version.

Click [Control Panel].

Click [View devices and printers].



In Windows 8.1/Server 2012/Server 2012 R2/Server 2016

Press the [X] key while holding down the [Windows] ( ) key.

Click [Control Panel].

Click [View devices and printers].



In Windows 7/Server 2008 R2

Click the Start menu.

Click [Devices and Printers].

If [Devices and Printers] is not displayed, click [Control Panel] - [View devices and printers].



In Windows Server 2008



Click the Start menu.

Click [Control Panel].

Click [Printers].



Open [Programs and Features]

In Windows 8.1/10/Server 2012/Server 2012 R2/Server 2016/Server 2019

Press the [X] key while holding down the [Windows] ( ) key.

Click [Programs and Features] (or [Apps & features]).

In Windows 7/Server 2008/Server 2008 R2

Click the Start menu.

Click [Control Panel].

Click [Uninstall program].


